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Preface 

For users who want both integrated software solutions and the freedom to 
choose their own mix of independent programs, sea Shell offers the best of 
both worlds. sea Shell gives you: 

• custom menus for selecting your programs 

• an easy-to-use interface for managing files that makes it unnecessary for 
you to deal directly with operating system utilities, 

• a custom work environment, and 

• a text editor. 

This guide is written for the novice user. Even without any prior computer 
experience, you should have no trouble understanding it. sea Shell itself is 
,easy to learn and use. If you do get confused, pressing the (Fl) key displays 
help screens appropriate to whatever portion of sea Shell you are currently 
using. 

You do not have to read the chapters in this guide in sequence, but it is a good 
idea to start with Chapters 1,2, and 3: "Introduction," "Getting Started with 
sea Shell," and "Running Applications under sea Shell." The later chapters 
assume that you are familiar with the information in these introductory 
chapters. 
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Chapter 1 

Introduction 

This chapter introduces you to sea Shell, its purpose, and its major features. 
It also outlines the rest of this user's guide, explaining what each chapter is 
about, defining formatting conventions used in the text, and the use of com­
mon keystroke commands. Read this chapter before going any further in this 
guide. 

What is seQ Shell? 
sea Shell is a friendly interface to the sea UNIX System V /386 Release 3.2 op­
erating system. Using sea Shell, you can select the applications available on 
your system from a single menu system, manage your files and directories, 
and run operating system utilities. The sea Shell window provides a central 
point from which you can reach the other parts of sea Shell. 

Some of the features that sea Shell offers you are: 

• custom menus for selecting your programs 

• a custom work environment 

• data integration through the Clipboard 

• file management tools 

• text editor 

The following sections describe these features. 

Custom menus for selecting your programs 

. The sea Shell screen features an Application menu that lists applications 
available on your system. To run a program on this list, just choose it from 
the menu. There is also a similar menu for operating system utility programs. 
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Introduction 

You can add or delete programs from the menu. You can also group similar 
applications together in application folders where they are available at your 
fingertips. For example, all the programs in a complete accounting package 
can go in one folder and the programs you use for order tracking can go in 
another. 

Custom work environment 

2 

The sea Shell screen is the first thing you see when you enter sea Shell. The 
default sea Shell screen looks like this: 

&enI"!3"" Manager Print Utility Options Quit 
Select an application 
/u/robert Frlday Apr11 12, 1991 10:42 

Mail - Electronic Mail 

.. / clipdir/ 
News/ memo. goodbye 
wastebasket/ memo. lunch 
announcement memo.meeting 
annual. report memo. review 
cash.advance memo. salary 
deadlines memo. specs 

memo.budget 

Apr 1991 
S M Tu W Th F S 

1 2 3 4 5 6 
7 8 9 10 11 1113 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 

performance 
report.expense status.2.12 
report.hires status.2.12 
report.plan status.2.26 
report. sales status.2.26 
report. space status.3.11 
specifications 

You can change the look of the sea Shell screen to suit your personal needs. 
By default, the sea Shell display consists of windows that list the available 
applications, the files in your current directory, and a calendar of the current 
month. You can change the size and look of anyone of these windows, and 
alter the format of the information they display. 

For example, if you do not usually need a certain window, you can remove it 
from the default sea Shell screen and enlarge another window to fill its space. 
The window you removed is still available, but only appears if you specifical­
ly ask to see it <through a menu selection or function key). You can restore the 
window to the default sea Shell screen at any time. 

seQ Shell Users Guide 



Contents of this guide 

Data integration through the Clipboard 

The Clipboard is the mechanism through which applications can exchange in­
formation. You copy information to the Clipboard from the program you are 
in, then paste it back from the Clipboard to another program. 

Suppose you are running MS-Word. You can move a mail message that you 
have received into an MS-Word document by saving the message to a file and 
then copying the file to the Clipboard. Then you start up MS-Word and paste 
the n1essage from the Clipboard back into your MS-Word document. 

Items posted to the Clipboard remain until you remove them, and you can 
store as many items on the Clipboard as you want. Thus, the Clipboard is a 
good place to store information that you plan to use again and again. 

sea products that support the clipboard include sea Portfolio®, MS-Word, 
FoxBASE+ ®, VP /ixTM, sea Lyrix®, and sea Integra™. 

Managing files 

sea Shell makes it unnecessary for you to deal directly with the operating 
system. Instead of memorizing complex commands to view, edit, copy, move, 
delete, or archive files, you can perform these tasks by selecting options from 
the sea Shell menu. 

Once you choose the task you want, sea Shell displays easy-to-understand 
FORMS in which you supply specific information; for example, the name of the 
file(s) you are erasing, the directory you want to create, and so forth. 

In many cases, you do not even need to type anything; using your terminal's 
ARROW KEYS, you can point out the files that you want from a list. 

Contents of this guide 

This guide contains all the information you need to use sea Shell effectively. 

Here are brief descriptions of the chapters in this guide: 

• Chapter 1, "Introduction," introduces sea Shell and describes this user's 
guide. 

• Chapter 2, "Getting started with sea Shell," explains how to start sea Shell 
and select options from the sea Shell menu. 

• Chapter 3, "Running applications under sea Shell," shows how to access 
applications from sea Shell. 
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• Chapter 4, "Managing your files," introduces files and directories, and 
explains· how to select files from a directory listing. Then, this chapter 
describes how to use the options on sea Shell's File menu to view, copy, 
rename, delete, and recover files; create and delete directories; change the 
current directory; change file permissions; and move files to and from 
backup media. 

• Chapter 5, "Sharing information among applications," discusses how to use 
the Clipboard to integrate data between applications. 

• Chapter 6, "Printing," explains how to send files to the printer. 

• Chapter 7, "Configuring your sea Shell environment," describes how to 
customize sea Shell to suit your personal preferences. 

• Appendix A, "Keystroke commands," lists all the keystroke commands that 
work with sea Shell. 

• Appendix B, "Menu options," lists all the options in the sea Shell menus. 

• The glossary provides short definitions for many of the terms used in this 
guide. All terms that appear in small capital letters, LIKE THIS, are included 
in the glossary. 

• Appendix C, "Setting up your printers," explains how the system adminis­
trator can configure printers to run with sea Shell. You must be logged in 
as root to set up printers. 

Conventions used in this guide 
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This guide uses the following documentation conventions: 

• When screen displays are shown in the text, they might not exactly match 
what you see on your screen. This is because sea Shell is configurable. 

• Words that you must type are in bold. 

• Special keys are in smaller type and enclosed in angle brackets, as follows: 

Key Notation 

(Return) 
(Esc) 
(Space) 
(etrI) 
(FI) 
(F2) 
(F3) 

Represents 

Return key 
Escape key 
Space bar 
Control key 
Function key 
Function key 
Function key 
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Keystrokes 

• When this guide introduces new terms or concepts, they appear in small 
capital letters, LIKE THIS; these terms are listed and defined in the glossary. 

Keystrokes 

The sca Shell supports a set of keystroke commands that move the cursor 
around the screen, insert and delete text on forms, and perform various other 
functions. You can use sca Shell efficiently without most of these commands. 
Once you have some experience, however, these keystroke commands can 
save you time. For a complete list, see Appendix A, "Keystroke commands." 

The following table lists some common keystroke commands: 

Command 

(Ctrl)x 

(Ctrl)y 

(Ctrl)t 

(Ctrl)v 

(Ctrl)r 

(Del) 

(Esc) 

(Return) 

Description 

executes a task using information in the current form. This 
is the same as pressing (Return) in the last FIELD of a form. 

deletes a line of text. While entering text in a field, this 
command deletes everything within the boundaries of the 
field. (In a multiline field, this command only deletes text 
from the line the cursor is on.) 

moves to the top of the screen, the first field of a form, or 
the beginning of the line in the editor. 

switches between Insert and Overwrite text-editing modes. 

refreshes the screen by removing any extraneous charac­
ters that are not part of a normal screen display. 

deletes a single character. 

exits the current form, menu, or list without executing an 
operation. If you are in a menu, you go up one level to the 
menu that precedes the current menu level. 

In Menus: selects a highlighted menu option. 
In Forms: moves to the next field in the form. 
Elsewhere: moves down one line. 
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Chapter 2 

Getting started with sea Shell 

This chapter covers some sea Shell basics: the parts of the sea Shell screen, 
how to use menus and forms, point-and-pick lists, function keys, and so on. 

The sea Shell screen is the central point for all sea Shell tools and other appli­
cations. From the sea Shell screen, you can run any of the applications and 
utilities available on your system. In addition, you can use the sea Shell 
screen to select files or directories to manipulate. In short, this screen is the 
central control panel for all of sea Shell. 

The main sea Shell screen is the first thing you see when you enter sea Shell. 
When you want to use another program under sea Shell, simply select it from 
the sea Shell's menu of application programs or its menu of utilities. The fol­
lowing table defines these types of programs. 

Application 

Utility 

a computer program, such as a spreadsheet or a word pro­
cessor, that you can access from sea Shell. 

a program that is part of the operating system; you access the 
operating system's utilities from the sea Shell screen using 
the Utility option. Utilities include such functions as who, ps, 
and Ips tat. 

sea Shell allows you to personalize your sea Shell screen by adding or 
removing applications and utilities to its menus. Thus, your sea Shell 
screen's Application and Utility menus might look different from the exam­
ples in this guide. 
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Starting sea Shell 

The following is a list of the features of this n1ain sea Shell screen and most 
other screens: 

o The STATUS LINE provides information about the sea Shell screen that you 
are viewing. With the exception of the context indicator .. the status line in 
this example is blank. 

o The context indicator is located to the right of the status line and displays 
the name of the current menu. The context indicator for the sea Shell 
screen shows "'&1tt!". 

o The menu line displays the menu items that are currently available. In this 
example, the menu line displays the main menu for sea Shell. The items 
available on this menu are Application, Manager, Print, Utility, Options, 
and Quit. 

o The description line gives a brief description of the highlighted menu item. 

o The divider line is the bar of text in reverse video that separates the menu 
and description lines from the display windows. The divider line in the 
sea Shell screen contains the current directory, the day of the week, the 
date, and the time. 

o The DISPLAY WINDOWS for the sea Shell screen include the Application, 
Calendar, and File windows, by default. 

o The file list contains a list of files and subdirectories in the current 
directory. 

Several types of windows and boxes can appear in front of the display win­
dows on the main sea Shell screen and other sea Shell screens. These include 
forms that you fill in and point-and-pick lists from which you choose items. 
In addition, sea Shell can display help screens and message boxes containing 
information on specific actions that you can take. When you finish using a 
window or box, it disappears and you can see the sea Shell screen display 
windows again. 

Depending on your terminal type, you might see a quick reference line below 
the display on sea Shell screens. This line shows the tools and utilities that 
you can access at any time with a single keystroke. The number to the left of 
each list item corresponds to a function key. For a description of the features 
that these keys call up, see "Quick reference keys" later in this chapter. 
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Using the seD Shell menu 
The following table summarizes the items that are currently available from 
the sea Shell menu. 

Option 

Application 
Manager 
Print 
Utility 
Options 

Quit 

Description 

selects and runs applications 
manages files and directories 
controls the printing utilities 
selects and runs operating system utilities 
edits the application and utility lists, and configures the 
sea Shell display options 
exits from sea Shell 

This guide describes each of these options in more detail later. 

Selecting menu items 
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When the sea Shell screen appears, the first item on the menu is highlighted 
automatically (this is true of any sea Shell menu when it first appears). When 
a menu item is highlighted, you can use that item, or any of the other items, 
on that menu. When no item on the menu line is highlighted, or the menu line 
is not displayed, it means that you are already running one of the tasks listed 
on the menu and therefore cannot make a selection. To return to the menu, 
you must press (Esc), at which point you can select another option from the 
menu. 

Use your terminal's (Space) bar or (Left Arrow) and (Right Arrow) keys to move 
the highlight to other menu items. To select the highlighted menu item, press 
(Return). You can also select an item by typing its first letter on the keyboard. 
In this case, you do not need to press (Return). For example, to select Options, 
simply type o. 

Selecting a menu item usually moves you down one menu level in the sea 
Shell program, and pressing (Esc) moves you up one level. If you are several 
levels down, you can return to the sea Shell menu by pressing (Esc) repeat­
edly until the menu reappears. 

sea Shell User's Guide 



Using forms and fields 

Using lower-level menus 

When you select Manager, Print, Options, or Quit from the sea Shell menu, a 
new menu of commands displays at the top of the screen. Notice that each 
time you move to a new menu, the context indicator changes to reflect the 
menu you are currently accessing. (The following chapters of this guide 
describe all the options on the sea Shell menu in more detail.) 

As an example, select Options from the sea Shell menu. The menu line 
changes to display the menu items for the Options menu. (Chapter 7, "Config­
uring your sea Shell environment," contains information on using the 
Options menu.) 

Two options on the sea Shell menu, Application and Utility, do not display 
new menus. Choosing Application moves the cursor to the sea Shell's Appli­
cation List window. You can then select and run one of the application pro­
grams listed there. If you choose Utility, a similar Utility List window 
appears. Use it to select and run operating system utility programs. 

Canceling an operation 

If you select a menu option by mistake, or if you want to interrupt an opera­
tion for any reason, simply press the (Esc) key. When you press (Esc), you 
return to wherever you were before you started the operation. 

Using forms and fields 
When you select a task from a menu, sea Shell usually responds by prompt­
ing for more information. Often, sea Shell displays a form over the current 
screen, with fields that you must fill in. A FIELD is a blank space where you 
enter text or numeric values from the keyboard. Other fields contain values 
you can select or in which you choose "Yes" or liNd' in response to a question. 

If you highlight a field and there is a long list of items from which to select, 
the message Press (F3) for list appears at the top of your screen. If you 
press (F3), you see a point-and-pick list; the next section explains how to use 
pOint-and-pick lists. For more information on the List Key, (F3), see the 
"Quick reference keys" section later in this chapter. 

After you fill in a field, press (Return) to continue to the next field. To move 
between fields without filling them, use the arrow keys. After you fill the last 
field in a form and press (Return), the form disappears and you see the sea 
Shell screen. 
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Using point-and-pick lists 
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If you select a task from a menu and sca Shell requires that you either fill a 
blank field or respond to a prompt, you must provide specific information. 
Depending on the task, you might have to supply a filename, a directory 
name, a device name, or something similar. 

If you know what to enter, you can type in the answer. However, if you are 
not sure what to enter, you can often display a list of all the possible answers 
and select the one you want. 

Such lists are called POINT-AND-PICK lists. To use these lists, point at the item 
you want by using the arrow keys to highlight it. Then, pick the item by press­
ing (Return) or (Ctrl)x. Some point-and-pick lists also let you select several 
items at a time. 

For example, if you want to view a file, you need to select the file from a list 
that appears on the SCQ Shell screen in the point-and-pick box. 

Enter the file(s) to view: lu/robertl 
lu/robert ' Friday April 12, 1991 9:28 

Mail 
System 

.. 
Newsl 
wastebasketl 
announcement 
annual. report 
cash. advance 
deadlines 

File list 

- Electronic Mail 
- Run a System Shell 

clipdirl memo.budget 
memo.goodbye report.expense 
memo. lunch report.hires 
memo.meeting report.plan 
memo. review report. sales 
memo. salary report. space 
memo. specs specifications 

Apr 1991 
S M Tu W Th F S 

1 2 3 4 5 6 
7 8 9 10 11 1113 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 

performance 
status.2.12 
status.2.12 
status.2.26 
status.2.26 
status. 3.11 
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Using point-and-pick lists 

At the top of the screen, you see the prompt to enter the name of the file that 
you want to view. Use the arrow keys to highlight the name of the file you 
want on the list at the bottom of the screen. (Alternatively, you can type in the 
filename.) When you press (Return), sca Shell displays the contents of the file 
that you selected. 

Picking several items at one time 

If you want to select more than one item at a time, simply move the highlight 
to each item and press the (Space) key. Each time you press (Space), an asterisk 
character (*) appears in front of the item. When you have marked everything 
that you want, press (Return). sea Shell selects each file marked with an aster­
isk for whatever option you chose. If you select three files to view, for exam­
ple, sea Shell shows you each file in tum. 

The (Space) bar acts as a toggle switch. Press it once to select an item; press 
(Space) again to remove the asterisk. 

To select every item on a point-and-pick list, press (Ctrl)v. An asterisk appears 
next to each item. Press (Ctrl)v again to unmark all the items. 

NOTE Some point-and-pick lists prevent you from choosing more than one 
item at a time. This happens when selecting several items makes no sense. 

For example, you can use only one printer at a time with sca Shell. Thus, a 
pOint-and-pick list of printers limits you to a single choice. 

Scrolling through the list 

If there are many list items to choose from, all of them might not fit in the 
point-and-pick list box at one time. In such cases, you can "scroll" additional 
parts of the list using your terminal's arrow keys and other cursor-movement 
keys. As you scroll forward, the items at the top of the list disappear and 
additional items appear at the bottom of the list. When you scroll back up, 
the earlier items reappear at the top and the later items disappear from the 
bottom. 

13 



Getting started with seQ Shell 

The SCROLL BAR shows your relative position in the list, including the part that 
is not currently displayed. The scroll bar is a small cursor-like marker on the 
right-hand side of the point-and-pick list box. Depending on your terminal, 
the scroll bar might be a "+" or another special character. As you scroll up 
and down the list, the scroll bar also moves up and down along the list's 
border. If all items in the list fit on the screen at once, the scroll bar does not 
appear. The following table describes how your terminal's cursor-movement 
keys scroll through a point-and-pick list: 

Key 

(Down Arrow) 

(Up Arrow) 

(Right Arrow) 

(Left Arrow) 

(PgDn) 

(PgUp) 

(End) 

(Home) 

Description 

moves the highlight down one item on the list. When the 
last item on the screen is highlighted, the list scrolls for­
ward one item. Pressing (Ctrl)j has the same effect. 
moves the highlight up one item on the list. When the first 
item on the screen is highlighted, the list scrolls backward 
one item. Pressing (Ctrl)k has the same effect. 
in a multi-column list, moves the highlight to the next 
column on the right. Otherwise, it moves the highlight 
down one item on the list. Pressing (Ctrl)l has the same 
effect. 
in a multi-column list, moves the highlight to the next 
column on the left. Otherwise, it moves the highlight up 
one item on the list. Pressing (Ctrl)h has the same effect. 
scrolls the list forward one "page" at a time 
scrolls the list backward one "page" at a time 
displays the end of the list. Pressing (Ctrl)e has the same 
effect. 
displays the beginning of the list. Pressing (Ctrl)t has the 
same effect. 

Quick reference keys 
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Sometimes, a computer program prompts you for information that you do not 
have available. In sea Shell, however, you can look up the information you 
need from inside sca Shell itself, using one of your terminal's QUICK REFER­

ENCE KEYS. By default, these quick reference keys are your terminal's 
FUNCTION KEYS. 
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Quick reference keys 

Here are the default assignments for the quick reference keys: 

Key Name 

Help 

Exit 
List 

Search 
Calendar 

Key 

(FI) 

(F2) 

(F3) 

(FS) 

(F6) 

Action 

calls up help screens that explain the feature that you are 
using 
exits quickly from any part of sea Shell 
displays special point-and -pick lists of reference 
information 
searches for an entry in a long point-and-pick list 
displays the Calendar window; if it is already displayed, 
the Calendar key displays past or future months in the 
Calendar window. 

You can access these features from any part of the sea Shell. 

The next few sections of this chapter describe the quick reference keys in more 
detail. If you are in a hurry to get started with sea Shell, you can skip this 
section and proceed to Chapter 3, "Running applications under sea Shell." 
After you use sea Shell for an hour or two, come back and read the rest of this 
section; it can help you use sea Shell more efficiently. 

If you need help while using sea Shell, press the Help key, (FI). This key dis­
plays a help screen with information about the part of sea Shell that you are 
currently using. HELP SCREENS give you the basic information that you need to 
use an unfamiliar feature. 

If a particular help message is longer than one screen, you can scroll forward 
and backward through it with the (Up Arrow), (Down Arrow), (Home), and (End) 
keys. See the section, "Using pOint-and-pick lists," earlier in this chapter for 
more information on using these keys. 

After reading the help text, press (Esc) to return to sea Shell, or press the Help 
key again for more help. If you press the Help key again, you see the Help 
menu at the top of the screen. 
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Exit key 
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The Help menu includes the following options: 

Option 

Continue 

Back 
Index 

Related 

Search 

Help 
Quit 

Description 

shows the next section of the current help screen, if any. If there 
is more help text, sea Shell highlights this menu option automati­
cally. 
displays the previous help screen 
displays an index of help screens in a point-and-pick list. The 
index includes a short description of each screen's topic. Use the 
arrow keys to select the topic you want more information on. 
displays a point-and-pick list of help screens that are related to 
the current topic 
searches for help screens that contain a particular word or phrase. 
You can search for occurrences of the word in the Help screen 
index listings. (discussed under the Index option, above), in the 
text of the help screens themselves, or both. When the search is 
finished, you see a point-and-pick list of each screen that contains 
the word or phrase. 
displays instructions for using Help screens 
returns you to sea Shell 

If you are not sure how to exit the Help screen system, simply press (Esc) once 
or twice to return to sea Shell. 

The Exit key, (F2), allows you to exit the task that you are performing quickly. 
Depending on the situation, pressing the Exit key performs a different action: 

• If you are performing a task from the Options menu, such as using Utillist 
to modify the Utility list, pressing the Exit key exits the current task, and 
sea Shell prompts you to save your changes before returning you to the 
main sea Shell window. 

• From any other submenu in sea Shell, pressing the Exit key exits the sub­
menu and places you in sea Shell's Quit menu. To exit sea Shell at this 
point, press (Return). If you change your mind about quitting, choose No to 
return to sea Shell. 

• If you are using an sea application, such as sea Portfolio, the Exit key 
exits the application and returns you to the sea Shell main window. How­
ever, some applications, such as the electronic mail program listed in the 
Applications list, do not exit when you press Exit. 
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List key 

Quick reference keys 

As mentioned earlier, programs sometimes prompt for information that you 
do not have. In seQ Shell, you can use the List key, (F3), in many fields to call 
up special point-and -pick lists of all possible entries. 

These lists do not appear until you press the List key, and they are not avail­
able from every field. When you move the cursor to a field that has such a list, 
a message at the top of the screen prompts you to press (F3). Pressing the List 
key causes the list to appear on the screen. Select the item you want; seQ 
Shell automatically inserts it into the field. 

These pop-up lists are available in various kinds of fields: 

• fields that require you to enter a filename or directory name. seQ Shell can 
display a list of all valid filenames or subdirectory names in your current 
directory. See Chapter 4, "Managing your files," for details . 

• fields that require you to choose a particular device for input or output, 
such as a disk drive or printer 

The List key works in other kinds of fields, too. If seQ Shell prompts you to 
press the List key in a particular field, a pop-up list is available. 

If you decide not to select an option from the list, press (Esc) to remove the list 
and return to the field. 

Search key 

As mentioned earlier, sometimes point-and-pick lists contain many items. If 
you know roughly what you are looking for, you can use the Search key, (F5), 
to find the item you want quickly. 

Suppose you are searching through a long point-and-pick list of files and the 
scroll bar indicates that the information you see is only part of the entire list. 
Rather than scrolling through the entire list for the one you want, press the 
Search key. seQ Shell displays this box: 

r 
.---------Search For-------...., 

1 

17 



Getting started with sea Shell 

Enter the name (or part of the name) of the file and then press (Return). SeQ 
Shell instantly scrolls the point-and-pick list to the first filename that includes 
the sequence of characters that you enter. 

If you press the (Up Arrow) key instead of (Return), the search proceeds 
upwards from your current position on the list to the first item. Otherwise, 
seQ Shell searches from your current position down the list. 

You can use the Search key on any point-and-pick list in any part of seQ Shell. 
You can also use the Search key to locate particular words or phrases while 
you are performing the following actions: 

• viewing a file through the View option of seQ Shell's File menu 

• editing or creating a file with the Edit option 

• reading help screens 

Calendar key 
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Your seQ Shell screen includes a CALENDAR WINDOW that looks like this: 

Apr 1991 
S M Tu W Th F S 

1 2 3 4 5 6 
7 8 9 10 11 1113 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 

The Calendar window shows the current month with today's date 
highlighted. To look at past or future months, press the Calendar key, (F6). 
You can use the (Right Arrow) and (Left Arrow) keys to move the calendar for­
ward or backward one month at a time. 

When you finish, press (Esc). The Calendar window reverts to the current 
month, and you return to the feature you were using when you pressed the 
Calendar key. 
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Issuing operating system commands 
from sea Shell menus 

Using a mouse under seD Shell 

You can run operating system commands at any point while using sea Shell. 
This gives you quick access to the operating system's resources without actu­
ally leaving sea Shell. 

From any sea Shell menu, simply type! followed by the command. When the 
command finishes, sea Shell prompts you to press any key to continue. 
When you press a key, you return to the same sea Shell menu you were in 
when you entered! 

For example, suppose you want to find out who else is logged into the com­
puter. The operating system command for this is who. To run this command, 
just type !who at any point and press (Return). Your computer displays a list 
of users on the screen; the list remains on the screen until you press a key. 
Then, the sea Shell display reappears. 

This feature is useful for running an operating system command and return­
ing to sea Shell quickly. If you want to spend more time with the operating 
system, you can run it from sea Shell as if it were an application. For more 
information, see Chapter 3, "Running applications under sea Shell." 

Using a mouse under seD Shell 
You can use a mouse with sea Shell if the appropriate hardware exists on 
your system. This hardware includes a supported mouse and at least a graph­
ics terminal that uses the scoterm terminfo entry or a system console that 
offers mouse support. (If you are not sure, ask your system administrator.) 

You can use the mouse whenever you are running sea Shell unless you are 
logged into the system remotely (for example, during an rlogin session). 

Use the mouse to: 

• choose menu items 

• move around forms 

• page forward and backward in lists 

• select items from point-and-pick lists 
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To use the mouse effectively, you must be familiar with the concept of a HOT 
WINDOW. The hot window is the area of your screen in which the mouse is 
currently active. Generally speaking, the hot window is the portion of the 
screen that is currently "popped up" (such as a form) above other screen infor­
mation (such as a calendar or other general data). If no pop-ups exist, the 
menu at the top of the screen is the hot window. 

On seOTERM terminals, the cursor changes from an "X" to an arrow when 
you move into the hot· window, allowing you to see where the mouse is 
active. On the console, the cursor always remains a solid block. In this case, 
remember that the mouse is active in the popped-up portion of the screen. 
For example, if you select a form from a menu, and then move to a point-and­
pick list from the form, the mouse is active in the point-and-pick list. 

Using the mouse 
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Your mouse behaves differently depending on the type of hot window that is 
active. The next four sections describe the actions you can take; they assume 
that you are using a three-button mouse. If your mouse has only two buttons, 
you lose the center button's functionality. Use the (Return) key instead. 

To choose a new hot window, click the left mouse button when the cursor is 
in that window. It is good practice to position the cursor in the border of the 
window before you click so you do not inadvertently make a selection when 
you click to make the window active. 

Menus 
The menu hot window consists of the lines containing the context indicator, 
the menu itself, and the menu description line. You can use the mouse to per­
form the following procedures in sea Shell: 

• To highlight the menu choice nearest to the mouse cursor, move the mouse 
cursor along the menu without pressing any mouse buttons. 

• To select a menu, press the left mouse button when the mouse cursor is on 
the desired menu choice. 

• To execute the highlighted menu choice, press the center mouse button. 

• To send an (Esc) to the terminal, press the right mouse button. 
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Exiting from sea Shell 

Forms 
Use the mouse to perform the following procedures in SeQ Shell forms: 

• To move to a desired form field, press the left mouse button when the 
mouse cursor is on the form field. 

• To move to the next form field, press the center mouse button. 

• To send an (Esc) to the terminal, press the right mouse button. 

Lists 
Use the mouse in lists to perform the following procedures: 

• To move one screenful up, press the left mouse button when the mouse 
cursor is on the top half of the list window. 

• To move one screenful down, press the left mouse button when the mouse 
cursor is on the bottom half of the list window. 

• To move one screenful down, press the center mouse button. 

• To send an (Esc) to the terminal, press the right mouse button. 

Point-and-Pick lists 
Use the mouse to perform the following procedures in point-and-pick lists: 

• To scroll through point-and-pick choices, move the mouse cursor up or 
down. 

• To select a desired choice, press the left mouse button when the mouse cur­
sor is on that choice. 

• To select the highlighted choice, press the center mouse button. 

• To send an (Esc) to the terminal, press the right mouse button. 

Exiting from seQ Shell 
When you finish using seQ Shell, follow these steps to quit: 

1. Select Quit from the seQ Shell menu. The seQ Shell Quit menu displays. 

2. Choose Yes to exit from seQ Shell. You return to the operating system or, 
if seQ Shell is the first thing you see when you log in to your computer, 
you logout. 
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Chapter 3 

Running applications 
under sea Shell 

This chapter explains how to call up and use applications from sea Shell. It 
also shows you how to access the operating system utility programs that 
come with sea Shell. 

By default, the sea Shell screen displays the list of available applications in its 
left top portion. This list, the APPLICATIONS LIST, contains all the applications 
that are currently available from sea Shell, such as Mail and the System shell. 
The Applications list might also include other applications, such as word pro­
cessor, spreadsheet, and database programs. You can access applications even 
if your sea Shell screen has been configured not to display the Application 
window. Details of these operations are given in this chapter. 

Regardless of how your setup of the sea Shell screen looks and which appli­
cations you are running, the instructions included in this chapter apply. 

Selecting an application 

When you select the Application option from the sea Shell menu, the sea 
Sh~ll menu disappears and the screen looks similar to the following example. 
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ee. 
lu/robert Friday Apnl 12, 1991 10:46 

all - Electronlc Mall 
System - Run a System Shell 

.. 1 clipdir/ 
Newsl memo.goodbye 
wastebasket 1 memo. lunch 
announcement memo.meeting 
annual.report memo.review 
cash. advance memo. salary 
deadlines memo. specs 

memo. budget 
report. expense 
report.hires 
report.plan 
report. sales 
report. space 
specifications 

Apr 1991 
S M Tu W Th F S 

1 2 3 4 5 6 
7 8 9 10 11 Ii 13 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 

performance 
status.2.12[ 
status.2.12 
status.2.26 
status.2.26 
status. 3.11 

Move the highlight over the desired application and press (Return) to run it. 
The opening screen of the application you select replaces the sea Shell screen. 

Using Application folders 
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An application folder can contain any group of programs, such as the applica­
tions in a specialized software package. When you select the folder, sea Shell 
displays the related applications together, so you can select them con­
veniently. If you often use a group of applications, working from within an 
application folder can eliminate unnecessary steps and make your job easier. 
You can add application folders to your Applications list yourself. For instruc­
tions on doing this, see Chapter 7, "Configuring your sea Shell environment." 

For example, suppose you use an accounting package that includes a general 
ledger program, an accounts payable program, an accounts receivable pro­
gram, a cost accounting program, and a payroll program. The folder might 
appear on your main Applications list like this: 
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Selecting an application 

.e. 
lu/robert Fnday Apr 12, 1991 10:42 

Mail 
System 

- Electronic Mail 
- Run a System Shell 

Apr 1991 
S M Tu W Th F 

ccounts... - Accounting Package 1 2 345 6 
8 9 10 11 II 13 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 

.. 1 clipdirl memo.budget performance 
Newsl memo. goodbye report.expense status.2.12 
wastebasket I memo. lunch report.hires status.2.12 
announcement memo.meeting report. plan status.2.26 
annual.report memo. review report. sales status.2.26 
cash. advance memo. salary report. space status.3.11 
deadlines memo. specs specifications 

The three dots ( ... ) after the Accounts selection indicates that this is an appli­
cation folder. When you select Accounts, seQ Shell displays the applications 
in that folder as a sub list, like this: 

Press (Esc) to return to the previous level. 
lu/robert FriddY Apr 12, 1991 10:42 

General -- General Ledger Apr 1991 
AR -- Accounts Receivable S M Tu W Th F S 

1 2 3 4 5 6 
8 9 10 11 1113 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 

AP -- Accounts Payable 
Cost -- Cost Accounting 
Payroll -- Payroll 
<Return to the previous level> 

.. / clipdir/ memo.budget performance 
News/ memo. goodbye report.expense status.2.12 
wastebasket/ memo. lunch report.hires status.2.12 
announcement memo. meeting report.plan status.2.26 
annual. report memo. review report. sales status.2.26 
cash.advance memo. salary report.space status. 3.11 
deadlines memo. specs specifications 
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You can now select one of these applications just as you select items from the 
main Applications list. To return to the main Applications list, select <Return 
to the previous level>. To return to the sea Shell menu without making a 
selection, press (Esc). 

An application folder can contain another application folder. 

Selecting and running a utility 
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The method for selecting and using an operating system utility program is 
very similar to that for selecting and using an application. Select Utility from 
the sea Shell menu. A list of the available utilities replaces the list of applica­
tions in the Application window. The display looks like the following: 

/u/robert Friday April 12, 1991 10: 42 

*Llst Users - Who is Logged on Apr 1991 
Compare 
Find 
Search 
Usage 
Disk Free 
Kill 
Processes 

.. / 
News/ 
wastebasket! 
announcement 
annual.report 
cash. advance 
deadlines 

- Compare Files 
- Locate a File 
- Text Search 
- Disk Usage 

S M Tu W Th F S 
1 2 3 4 5 6 

7 8 9 10 11 1113 
- Space Available 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 - Kill A Program 

- List My Processes 

clipdir/ memo.budget performance 
memo.goodbye report.expense status.2.12 
memo.lunch report.hires status.2.12 
memo.meeting report. plan status.2.26 
memo.review report.sales status.2.26 
memo. salary report. space status.3.11 
memo. specs specifications 

To run a utility, move the highlight to the desired utility and press (Return). 
The information from the utility that you are running replaces the sea Shell 
screen. For example, if you select List Users from the list of utilities, a list of all 
the users who are currently logged into the system is displayed in the win­
dow. To return to the sea Shell menu after running a utility, press (Return). 
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Running the operating system as an application 

Using Utility folders 

A utility folder is very similar to an application folder; it can contain a list of 
utilities and other utility folders, usually a group that is related in some way. 
When you select the folder, the utilities appear together. For information on 
adding or removing utility folders to your Utilities list, see Chapter 7, "Con­
figuring your sea Shell environment." 

Running the operating system as an application 

You can reach the operating system directly from almost any point in sea 
Shell. If you want to run a single operating system command from any menu 
in sea Shell, simply press the "!" key, followed by the command that you 
want to run. sea Shell "escapes" to the operating system to run the command; 
,when the task is complete, you return automatically to the same sea Shell 
menu '\-vhen you press any key. 

If you want to run more than one operating system command from the sea 
Shell, you can run an operating system SHELL just as if it were an application. 
With this feature, you can perform extended operating system tasks and 
return to the sea Shell as needed. 

To do this, first select the Application option from the sea Shell menu. Now, 
select the shell from the Applications list. When you choose a shell option 
from the Applications list, you immediately enter an operating system shell. 
When you finish using the operating system shell, type exit at the shell 
prompt to close the shell and return to sea Shell. 

By default, an operating system shell is already listed as an option on your 
Applications list. If it has been deleted for some reason, you can add it using 
the sea Shell menu's Option selection. For details, see "Editing the Applica­
tions list" in Chapter 7, "Configuring your sea Shell environment." 
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Chapter 4 

Managing your files 

sea Shell allows you to manage and organize your files without resorting to 
complex operating system commands. Using the options on sea Shell's Man­
ager menu, you can copy, rename, and remove files; create and remove direc­
tories; change the permissions on your files; save and retrieve files from 
backup media; and access the Clipboard. 

This chapter gives a basic introduction to files and directories, then describes 
how to select files and change directories through sea Shell. Finally, it 
describes the Manager menu options in detail. 

Using files and directories 

One of the most useful things about computers is their ability to store infor­
mation; information is stored in FILES. When you use an application, it gen­
erally creates a file to hold your work; this is one way files are created. 

Every file has a name and some contents. A file usually contains some piece 
of information, such as a letter, report, or phone list. The filename is a label 
you give the information to keep track of it. 

A computer can contain thousands of different files. To keep this huge group 
of files manageable, the operating system splits up these files among tens or 
hundreds of different DIRECTORIES. You can think of a directory as a place 
where the computer keeps a set of files. Files that belong to a certain person 
or files associated with a particular program are often stored in a directory of 
their own. To see a particular file, you have to go to the directory that holds it. 
Each directory has a name, just like a file. However, while a file holds infor­
mation, a directory holds files and other directories, known as subdirectories. 
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When you log into your computer, you are in your HOME DIRECTORY. This is 
where you keep your own files and do your work. The name of your home 
directory is probably the same as your login name. 

After a while, files start to accumulate in your home directory. To keep things 
organized, you should create some SUBDIRECTORIES within your home direc­
tory. A subdirectory is a directory within a directory. If you keep several 
different types of files in your home directory, you can create subdirectories 
for each type and divide your files among them. Then, when you want to 
work with a particular group of files, simply switch over to the subdirectory 
that holds them. 

For example, you might create a letters directory in which to keep your letters, 
and separate directories for particular projects you are working on. You can 
further divide your new directories. For example, you can make new sub­
directories in your letters directory to organize your letters by person or sub­
ject. There is no limit to the number or kinds of subdirectories you can create. 

Almost every directory on the computer is a subdirectory of some other direc­
tory. The directories are organized into an inverted tree structure, so called 
because directories branch out of other directories like the branches of a tree. 
This tree is "inverted" because the branches move down, not up. One direc­
tory, at the top of the tree, is not contained in any other directory. This is 
called the root directory, and its name is a slash character (/). To help clarify 
this, look at the following picture of part of a typical directory tree. 
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In this diagram, directories are depicted by ovals, while files are rectangles. 
Notice that all of the directories have lines coming out of them, indicating that 
they lead to files or other directories. The files do not have any lines coming 
out of them. Files do not lead to other files or directories. Remember that this 
is only a small portion of the entire directory tree. In reality, most directory 
trees are much deeper than four levels, and each level contains many more 
than four files and directories. 

Pathnames 

.Any file or directory on the computer can be specified uniquely by its 
PATHNAME. A pathname is like a map with directions for finding a file or 
directory; it lists, in order, each directory you must pass through to get from 
the root directory to the file or directory in question. When the pathname is 
written down, the directories are separated by slashes (/). Remember that 
the slash character is also the name of the root directory; the first slash in a 
pathname stands for the root directory, while the others are used to separate 
directories. 

For example, the full path of the file called review in the diagram above is 
jusr/robert/review. The pathname tells you that review is in the directory called 
robert, robert is a subdirectory of usr, and usr is in the root directory. 
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A pathname that begins at the root directory is called an ABSOLUTE PATHNAME 
or FULL PATHNAME. Pathnames that begin at some level below the root direc­
tory, called RELATIVE PATHNAMES, are also useful. When you work in one 
directory, you can specify a file or directory below it by its relative pathname. 
For example, if you are working in the directory called usr and you need to 
specify the file in robert called mbox, you can use the relative pathname 
robert/mbox. 

The current directory 

The directory you are working in at the moment is called your CURRENT DIREC­

TORY. When you first log into your computer, your home directory is your 
current directory. Whenever the Manager menu is displayed on your screen, 
the files in your current directory are also listed. You can change your current 
directory at any time. (This process is described later in this chapter.) 

Naming and organizing files and directories 
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Here are a few important rules to follow when you name files and directories: 

• Names cannot be longer than fourteen characters. 

• No two files in the same directory can have the same name. 

• Do not use blank spaces. 

• Do not use control characters in filenames. (Control characters are keys 
pressed while holding down the (Ctrl) key.) 

• Do not use any of the following characters in filenames: 

!"/;/\$*&<>() I {}[]-

These characters are reserved for operating system commands. 

It is a good idea to use filenames that describe the contents of the files and are 
easy to type. For example, a file containing a letter to your friend Bob would 
be more appropriately called bob.letter than xxx or 5il%ds, although all of these 
are acceptable filenames. 

It is very easy to let your files pile up in one directory until it is difficult to find 
anything. Always create more subdirectories when you need them. 

The Manager menu options make it easy to create and remove files and direc­
tories, and to move up and down the directory tree. These operations and 
others are described later in this chapter. 
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The Manager menu 

The Manager menu 
To get to the Manager menu, select the Manager option from the sea Shell 
menu. The Manager menu appears at the top of the screen: 

iDII Edit File Directory Archive Transfer Preferences Quit 
Displays a file 
/u/robert Fnday April 12, 1990 10:44 

If you are unfamiliar with the parts of the screen, see Chapter 2, "Getting 
started with sea Shell." For an explanation of how to alter the screen display, 
see Chapter 7, "Configuring your sea Shell environment." 

Here are brief descriptions of the options on the Manager menu: 

Option 

View 
Edit 
File 
Directory 
Archive 

Transfer 

Preferences 
Quit 

Description 

displays the contents of one or more files 
edits text files 
finds and manipulates files 
changes to and manipulates directories 
moves files to or from backup media; also, lists the files 
already on the backup media, and formats blank media 
moves items to and from the Clipboard, and deletes items 
from the Clipboard 
specifies text line length and default text editor 
exits the Manager menu 

These options are discussed in detail in "Using the Manager menu options" 
later in this chapter. All of these options, except Directory and Quit, require 
you to select a file or a group of files. The following section explains this 
procedure. 
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Basic commands 

Many of the tasks that the Manager menu options can perform involve two 
basic steps: first you specify what you want to do (by selecting a menu 
option), and then you indicate to which file or files you want to do it. Thus, 
before you can really use all the options on the Manager menu, you must 
know how to: 

• select options from a menu, and 

• select files from the directory listing. 

Fortunately, this is pretty straightforward. If you have had any experience 
with computers, these basic commands are intuitive, and you might want to 
skim this section. 

Selecting a menu option 

There are two ways to select an option from a menu: you can either type the 
first letter of the option name and press (Return), or you can use the arrow 
keys or (Space) bar to move the highlight to the option name and press 
(Return). 

Selecting files 
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Many of the operations that you can perform with the Manager menu options 
require that you select the files that you want to operate on. For example, if 
you choose the Copy option, you must tell sea Shell what file to copy. You 
can do this by typing the name of the file you want, or by selecting it from a 
point-and-pick list of all files and subdirectories in your current directory. In 
addition, you can select several files at a time, and choose files from one of the 
subdirectories. 

Choosing files 
There are three ways to pick a file: 

• type the filename, 

• use the arrow keys to move the highlight to the filename in the point-and-
pick list, 

• if you are looking through a long list, you can use the Search key, (FS). 

When you have found and selected the file by one of these methods, press 
(Return) to execute the selection. 
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Basic commands 

You can also select several files at a time. If you are selecting files via the 
point-and-pick list, simply move the highlight to each file you want and press 
the (Space) bar. Each time you do this, an asterisk (*) appears in front of the 
filename. When you have finished, press (Return) to select every file marked 
with an asterisk. For more information on point-and-pick lists, see Chapter 2, 
"Getting started with sea Shell." 

If you are typing in names rather than pointing and picking, selecting several 
files at a time is somewhat different. To select three different files for an opera­
tion, you cannot simply enter three separate filenames at once; sea Shell 
accepts only one at a time. Instead, you can type instructions telling sea Shell 
to display all files whose names share certain characteristics. This technique 
is described later in this chapter, under "Using wildcard characters." 

If you want to find a file or a number of files, you can use the File Find com­
mand and specify a filename or part of a filename to search for. The file(s) 
that match the name that you specify appear in a list, and you can choose one 
or more files from this list for the option you are working with. This method 
of choosing files is explained in "Managing files" later in this chapter. 

Changing directories 
If the file you want is in a subdirectory of the current directory, you must first 
select that directory as you select files. You can type the name of the direc­
tory, or you can move the highlight to the directory name. Directories are dis­
tinguished from files in the listing on the screen because a directory is always 
followed by a slash (I). 

After highlighting the directory, select it by pressing either (Return) or the 
greater than symbol (». A list of the directory's files then appears on the 
screen. Now select the file(s) you want. When you finish working, your home 
directory listings reappear. 

If you need to move up to a directory above yours (as from /u/robert to /u), 
press the" <" character. You can also select the symbol for the next directory 
up, " .. I" (dot dot slash), which appears at the beginning of every list of direc-
tories and files. . 

To move to a directory that is not in the current directory or in the directory 
above it, use the Manager ¢ Directory ¢ Change command to search for and 
move to a directory with a specified name. For more information on this com­
mand, see "Managing directories" later in this chapter. 

Using wildcard characters 
sea Shell understands two WILDCARD CHARACTERS that make selecting files 
more efficient. When used in a filename, the wildcard characters stand for 
other characters, just as a wildcard does in a deck of playing cards. 
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When telling sea Shell what file(s) you want, you can use wildcard characters 
to display, for example, every file that begins with the letter liT", or every file 
that contains the numeral "2". Here are the two wildcard characters you can 
use: 

Character 

* 
? 

Stands for 

zero or more characters 
anyone character 

By using the wildcard characters, you can quickly display a precise subset of 
the files in your current directory. Then, you can select the files you want 
from the subset. To illustrate this, let's say that the current directory contains 
the following files: 

chI.startcar.dcx ch2.runcar.dcx ch3.repairs.dcx ch3.repairs.pst 

When you have selected a subset of files using a wildcard character, you can 
select from the subset using the (Space) bar, and then pressing (Return) to carry 
out the functions you require. 

Use the asterisk (*) to replace any string of zero or more characters. By itself, 
1/ *" means "all files." Here are a few examples of file displays using the II * " 
character: 

Type 

chl* 

*.dcx 

To Display 

all files beginning with chI 

all files ending with .dcx 

all files containing car 

Files Displayed 

chl.startcar.dcx 

ch 1.startcar .dcx 
ch2.runcar.dcx 
ch3.repairs.dcx 

chl.startcar.dcx 
ch2.runcar.dcx 

The question mark (?) replaces any single character. Here are some examples: 

Type 

ch3.repairs. ??? 

ch?*.psf 

To Display 

all files with ch3.repairs. followed 
by three characters 

all files starting with ch and a 
character, and ending with .pst 

Files Displayed 

ch3.repairs.dcx 
ch3.repairs. psf 

ch3.repairs. psf 
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Canceling an operation 

If you ever select an option by mistake, or if you want to interrupt an opera­
tion for any other reason, just press the (Esc) key. When you press (Esc), you 
return to wherever you were before you started the operation. 

Error messages 

It is possible for you to ask sea Shell to do something that cannot be done. 
For example, you might try to copy a file that does not exist (by mistyping the 
filename, for instance). When something like this happens, an ERROR MESSAGE 
appears at the bottom of the screen. This message should give you the infor­
mation you need to correct the problem. After reading the error message, 
press (Return) to continue. 

Using the Manager menu options 
The following sections discuss the tasks that you can perform with the 
options on the Manager menu. 

Looking at a file 

You can display the contents of a file on your screen with the View option. 
When you select View, a listing of the files in your current directory appears. 
Here is an example: 

Enter the file to view: lu/robertl 
lu/robert Friday April 12; 1991 10:44 

Mail 
System 

- Electronic Mail 
- Run a System Shell 

QlDEELiaaa review dead. letter mbox 
lenore.notes maill 

Apr 1991 
S M Tu W Th F S 

1 2 3 4 5 6 
7 8 9 10 11 Ii 13 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 
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Now you can select the file or files that you want to view. (If you are not sure 
how to do this, see "Selecting files" earlier in this chapter.) 

In the example above, the File window covers roughly half of the screen. 
Your main sea Shell screen, however, might be configured for a larger or 
smaller File window, that is, one that fills all of the screen or a quarter of it. 

If there are more files than can appear in the window at one time, use the 
(Down Arrow) key to "scroll" the additional listings into the File window. You 
can also use the (PgUp) and (PgDn) keys to move up and down through the 
listings one "page" at a time. In addition, the (Home) and (End) keys move you 
to the beginning and end of the file listings, respectively. 

After you make your selection, the first screenful of text appears on the 
screen. In the following example, the file mbox is being viewed: 

Currently viewing /u/robert/mbox 

/robert Fnday Apnl 12, 1991 10:44 
From robert Fri Apr 12 14:31:16 1991 
To: lenorek 
Subject: interface design spec review 
Cc: edwarde robert 
Date: Fri Apr 12 14:32:31 1991 

Have you had a chance to look at that review I asked you to do yet? Do 
you think the due date of May 30th is reasonable? 

-Rob 

From lenorek Mon Apr 1 9:06:13 1991 
To: robert 
Subject: interface design spec review 
Date: Mon Apr 1 9:09:47 1991 

The review is going well, Robert - I'll definitely be done 
by the end of the month. 

-Lenore 

You can now scroll through the file to read it. These are the keystrokes that 
you can use with View: 
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Keystroke 

(Esc) 

(UpArrow) 

(Down Arrow) or (Space) 
(PgDn) or (Return) 

(PgUp) 

(Home) 

(End) 

Using the Manager menu options 

Action 

exits the file 
moves up one line 
moves down one line 
moves down a page 
moves up a page 
moves to the top of the document 
moves to the bottom of the document 

Press (Esc) when you finish viewing the file. If you select more than one file to 
view, the first screenful of the next file is displayed. Otherwise, you return to 
the sea Shell menu. 

Editing a file 

You can edit the contents of a text file using the Edit option in the Manager 
menu. When you select Edit, a listing of the files in your current directory 
appears, as explained in the previous section, "Looking at a file." 

Select the file or files that you want to view. (If you are not sure how to do 
this, see "Selecting files," earlier in this chapter.) Once you select a file, the 
first screenful of text appears on the screen. 

Editing commands 
To edit a text file, use the Edit Mode commands available for editing text in 
form fields. For a full listing of the editing commands, see Appendix A, "Key­
stroke commands." The following table gives a brief introduction to the edit­
ing commands. 
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Command 

Arrow keys 

(PgUp) or (PgDn) 

(Home) 

(End) 

(Esc) 

(Ctrl)gi 
(Ctrl)g! 
(Ctrl)n 
(Ctrl)p 
(Ctrl)w 

(Ctrl)y 
(F8) 

(Ctrl)o 
(Ctrl)v 

(Ctrl)z 

(F5) 

Description 

moves the cursor up and down through the file, and to 
the right or left on each line 
use (PgUp) to jump back to the previous page, or (PgDn) 
to jump forward to the next page. A "page" is one screen 
of lines. 
moves the cursor to the beginning of the current line 
moves the cursor to the end of the current line 
switches between editing the file and using the Edit 
menu 
moves to the top of the document 
moves to the bottom of the document 
moves the cursor to the next word 
moves the cursor to the previous word 
deletes the word the cursor is on, if the cursor is on the 
first character of the word 
deletes the current line (the line the cursor is on) 
pastes a deleted line back into the file. The Edit program 
stores the last 10 lines you deleted. When you press (F8), 
the last line you deleted reappears. If you press (F8) 
again, the next to last line you deleted reappears, and so 
on. 
inserts a blank line above the current line 
switches between Insert and Overstrike mode. You are 
in Insert mode to start. If you move the cursor to some 
existing text and begin typing, the new words are 
inserted between the existing words. If you press (Ctrl)v 
to change to Overstrike mode, the words you type 
replace (overstrike) any existing words on the same line. 
Press (Ctrl)v again to return to Insert mode. 
calls up the pop-up list of extra file-editing and format­
ting options. This is the same as pressing (F9). 

prompts you to enter a word, then searches for the next 
occurrence of that word in your file 

Pop-Up list Of extra edit-mode commands 
When you press (F9) in Edit mode, a list of extra editing commands appears 
on the screen, like this: 
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.-----Extra Commands-------, 
* Format Paragraph 

Join Lines 
Margin (set) 
Delete Line (~Y) 

Paste (undelete, (Fa») 

To choose a command from this list, position the highlight bar over the com­
mand that you want and press (Return). To use the Format Paragraph, Delete 
Line, and Join Lines commands, you must position the cursor on the line or 
paragraph that you want before pressing (F9). 

The following table describes the commands on the Extra Commands list: 

Command 

Format Paragraph 

Join Lines 

Margin (set) 

Delete Line ("y) 

Paste (undelete, (F8» 

Description 

reformats the paragraph that the cursor is on. This 
command fills each line with text out to the margin, 
moving text up from subsequent lines as necessary. 
joins the line the cursor is on with the text of the 
next line. If both lines together are too long to fit 
within the file margin, only part of the text from the 
second line is joined to the first. 
resets the line length for this file. The default line 
length appears in a box. Type in the new line length 
and press (Return). If you type in new text now, the 
text automatically breaks to a new line after reach­
ing the line length that you set. To reformat existing 
paragraphs to the new line length, use the Format 
Paragraph command. To reset the default line 
length for all editing, use the Preferences command 
in the Edit Menu. 
deletes the line that the cursor is on. This option is 
the same as pressing (Ctrl)y. 
pastes deleted lines back into the file. When you 
choose Paste, the last line that you deleted reap­
pears. If you choose Paste again, the next to last line 
that you deleted reappears, and so on, up to a max­
imum of 10 lines. Choosing Paste is the same as 
pressing (F8). 
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To configure or extend your editing powers, press (Esc) while editing a file. 
The Edit menu appears, with the following options: 

(Esc) to resume editing 
~ Include Transfer Quit 
Edit document 
/u/robert Friday April 12, 1991 10:44 

The options in the menu are described briefly in the following table: 

Option 

Edit 
Include 
Transfer 

Quit 

Description 

invokes the Auto Editor you specify 
includes a file in the current document 
moves items to and from the Clipboard, and deletes items from 
the Clipboard 
saves your work, exits the editor, and returns to the Manager 
menu 

If you choose the Edit option, the text of the file appears, and you can edit it 
using the Auto Editor you specify. 

Select the Include option to include another file in the file that you are 
currently editing. When you select Include, a pop-up window appears listing 
the files in the current directory. Use the cursor-movement commands to 
select a file. 

The Transfer option allows you to access the Clipboard while you are editing 
a file. You can use the Clipboard to transfer text and other forms of data 
between different applications. See Chapter 5, "Sharing information between 
applications," for more information about using the Clipboard. 

The Quit option exits the Edit Mode and returns you to the Manager menu. 
Quit also saves your latest changes to the current file. 
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Use the File option in the Manager menu to organize and manipulate files. 
When you select the File option, the following menu appears: 

~ Rename Erase Find Unfind Permissions WasteBasket 
Copies a file 
/u/robert' , Friday April 12, 1991 10:44 
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Here are brief descriptions of the options in the File menu: 

Option 

Copy 
Rename 

Erase 
Find 
Unfind 
Permissions 
Wastebasket 

Description 

makes a copy of a file or a group of files 
changes a file's name, or moves a file or group of files to a 
different directory 
puts one file or a group of files in the wastebasket 
lists files that match specified criteria 
lists files in the current directory, rather than the "Find" list 
changes the permissions on your files 
recovers or removes files from the wastebasket 

The following sections discuss the tasks that you can perform with the 
options of the File menu. 

Copying files 
Use the Copy option to make a copy of one or several files at a time. You can 
place the copy in any directory for which you have the correct permissions. 
For more information on file permissions, see "Changing permissions" later in 
this chapter. 

After you select the Copy option from the File menu, a list of the files in your 
current directory appears, along with a message asking you to select the file(s) 
that you want to copy. 

Choose the appropriate file(s). When you make a selection, another messagE: 
appears. This one asks you to select the file to copy to. Now you must select 
a destination for your file(s). 

If you are copying a single file, you can enter any filename that does not 
already exist. Do not enter the name of a file that already exists; doing this 
overwrites the contents of the file, replacing them with the new data. If you 
specify a directory only, a copy of your file with its original name is put in 
that directory. If you are copying a group of files, you must specify a direc­
tory as a destination. 

Examples 

This first example creates a backup copy of the file review called review.bak. 
First, select the Copy option. The File menu disappears, and you are asked to 
enter the name of the file from which you wish to copy. In this case, type 
review. The word appears after the pathname /u/robert. 
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Now press (Return) to execute the selection. At this time, you are asked to 
enter the name of the file to which you want to copy. In this case, type 
review.bak and press (Return). The File menu appears. There is now a file 
called review.bak in the directory /u/robert, containing an exact copy of the file 
review. 

Here is another example. This time, copy the files dead.letter and mbox into the 
directory mail. Again, you must select the Copy option. Now mark the files 
to be copied by moving the highlight to each file and pressing (Space). See 
"Choosing files" earlier in this chapter if you are not sure how to do this. This 
is what the screen looks like after you mark the two files: 

Enter the file to copy from: /u/robert/ 
/u/robert Friday April 12, 1991 10:44 

Mail - Electronic Mail 
System - Run a System Shell 

id.spec review 
lenore.notes mail/ 

*dead.letter 

Apr 1991 
S M Tu W Th F S 

1 2 3 4 5 6 
7 8 9 10 11 DI 13 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 

Now, press (Return) to execute the selection. The "copy to" line appears, just 
as in the previous example. Type mail or highlight mail/ on the screen to 
select the mail directory. Notice that the "copy td' line changes to indicate 
that you are in the mail directory. When you press (Return) copies of the two 
files are placed in the mail directory, and you return to the File menu. sea 
Shell gives the copies the same names as the original files. 

Renaming and moving files 
The Rename option is used both for changing the name of a file and for mov­
ing files from one directory to another. Using the Rename option is just like 
using the Copy option, but you do not leave a copy of the file in the original 
location. You perform the same steps to rename a file as to copy a file, and the 
procedures involved in moving files to a different directory are just like those 
used to copy files to a different directory. 
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When you select the Rename option from the File menu, a message appears, 
prompting you to select the file(s) that you want to rename. 

When you have made your selection, a new message appears, prompting you 
to enter the new filename. At this point, you select a destination for your 
file(s). 

• If you are renaming a single file, you can specify any filename that does not 
already exist; the file is then renamed (that is, moved to a new filename) . 

• If you specify a directory, your file moves into that directory, keeping its 
original name. If you are renaming a group of files, you must specify a 
directory as a destination. 

Refer to "Copying files" earlier in this chapter for more detailed information. 

Removing files 
To remove files, use the Erase option; this option does not remove directories. 
(See "Managing directories" later in this chapter for information on renaming 
a directory.) When you select the Erase option, you remove the File menu 
from the screen. You are prompted to select the file(s) that you want to erase. 
Once you select the files, you return to the File menu. The directory listing is 
updated to show that the files were erased. 

When you erase a file, sea Shell places it in your wastebasket directory. The 
file remains there until you exit sea Shell. You can recover files from the 
wastebasket with the Wastebasket option (see the section, "Recovering erased 
files"). When you exit sea Shell, all the files in the wastebasket directory are 
permanently deleted, and there is no way to recover them. 

Finding files 
The Find option lets you search for and list files with specified names. When 
you select the Find option, a form appears, with a field for specifying the full 
or partial filename that you want to search for. The form looks like this: 

.--------File Search--------, 
Filename or partial name: [ 

Use the full filename if you want to find just one file. If you want to find a 
number of files with similar names, specify the part of each filename that is 
the same, and use wildcard characters for the rest of the filename. For exam­
ple, to list all files with the .dcx extension, enter *.dcx in the "Filename" field. 

Note that the resultant listing might contain files from numerous different 
directories at different levels of your directory tree. If you no longer want to 
see the listing of files from different directories, and instead you want to dis-
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play only the files in your current directory, choose the Unfind option in the 
File menu. After choosing Unfind, you can no longer see files in numerous 
different directories in your directory tree. 

You can use the Find option to carry out a task on several different files in a 
list. First use the Find option to display the list of files. Choose a task option 
from the File menu. Finally, choose the files to be acted upon. 

Managing file permissions 
Every file or directory has a set of PERMISSIONS that control who can read 
them, change them, and execute them. With the Permissions option, you can 

. change permissions on files and directories you own to make them more or 
less accessible to other users on your system. 

How permissions work 

Each file has three different sets of permissions: one for the user, the owner of 
the file; one for the group, the other users in your work group; and one for all, 
meaning everyone on your system. Each set of permissions can include none, 
one, or more than one of the following privileges: 

• Read 
For a file, this means you can look at its contents on the screen. For a direc-
tory, this means that you can see a list of the files it holds. Read permission 
for the directory does not automatically give you read permission for every 
file in the directory. 

• Write 
For a file, this means that you can alter its contents or remove it. For a 
directory, this means you can create files and subdirectories within that 
directory. 

• Execute 
For a file, this means you can run a program that the file contains. Execute 
permission on a directory means you can change to it and use files within 
it. 

When you create a file or directory, it acquires a standard set of permissions 
automatically. For example, a typical configuration might give the user (your­
self) read and write permissions. Other users, both your group members and 
all other users, might have only read permission. 

Changing permissions 

The Permissions option lets you change the permissions on one file or direc­
tory at a time. This option also shows you the current permissions. 

To change permissions on a file or directory, proceed as follows: 
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1. Select the Permissions option from the File menu. In response, this mes­
sage appears: 

Enter the file to be changed: lu!robert! 
ii'&..I!.++'.!.§ 

/u/robert 0 Friday April 12, 1991 10:44 

2. Now, select the file or directory you want to change. Remember, you can 
select only one at a time on this form. The File Permissions form now 
pops up on the screen: 

r-------File Permissions--------, 
User Read [i] Write [*] Execute [ ] 
Group Read [*] Write [] Execute [ ] 
All Read [*] Write [] Execute [ ] 

Owner: [robert 
Group: [pubs 

The form displays the current permissions for the file you selected, and the 
owner and owner's group. The asterisks between the brackets show who 
has which permissions. In this example, the User (owner) has Read and 
Write permissions, while Group and All have only Read permissions. This 
means that anyone can read the file, but only the owner can change it. No 
one can execute it. 

3. To grant additional permissions for User, Group, or All, move the 
highlight to the appropriate permission field and press the (Space) bar. An 
asterisk shows that you have added this permission. Use the (Up Arrow), 
(Down Arrow), and (Return) keys to move around on this form. 

To remove permissions press the (Space) bar in a field that already has an 
asterisk: the asterisk disappears. 

4. You can change the values in the "Owner" and "Group" fields if you are 
the owner of the file. 

5. When you have finished, press (Return) in the last field ("Group"), or sim­
ply press (Ctrl)x with the cursor at any point on the screen. This makes the 
changes to the file or directory that you requested, and then returns you to 
the File menu. 

Viewing permissions without changing them 

If you just want to see what a file's permissions are, select it through the Per­
missions option but make no changes. Simply press (Esc) when you have 
finished looking at the File Permissions form. 
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Your File window can also show you a file's permissions if the window is con­
figured to show "system" file listings; that is, listings that show detailed techn­
ical information about each file. For details on doing this, see Chapter 7, "Con­
figuring your sea Shell environment," in this guide. 

Recovering erased files 
The WASTEBASKET option lets you manipulate the files in your wastebasket 
directory. When you select the Wastebasket option, this menu appears: 

~ Delete Clear 
Recovers a file from wastebasket 
/u/robert Friday April 12, 1991 10:44 

Here are brief descriptions of the Wastebasket menu options: 

Option 

Select 
Delete 
Clear 

Description 

recovers a file or group of files from the wastebasket 
permanently erases a file or group of files from the wastebasket 
permanently erases all of the files in the wastebasket 

If you choose the Select or Delete option, a list of the files in the wastebasket 
appears on the screen. You can then select the file(s) that you want to recover 
or delete. If you are not sure how to do this, see "Selecting files" earlier in this 
chapter. 

I NOTE Any file that you recover from the wastebasket appears in your 
cu. rrent directory. If you have changed directories since removing the file, it 
does not appear in the directory where it was before. 

If you choose the Clear option, all the files in the wastebasket are permanently 
removed. The wastebasket is cleared automatically each time you exit sea 
Shell. 
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The Directory option in the Manager menu lets you take a number of actions 
on directories. When you select the Directory option, the following menu 
appears: 

~ Make Remove Permissions 
Changes current directory to another directory 
/u/robert Friday April 12, 1991 10:44 
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The options on this menu allow you to change to a new current directory, 
make new directories, remove empty directori~s, and change directory per­
missions. These operations are discussed in the following sections. 

Changing the current directory 
To make a different directory your current directory, select the Change option 
from the Directory menu. In response, a message appears, prompting you to 
select the new current directory. Also, the File window changes to show only 
the subdirectories in your current directory; normal files are not displayed. 

Now select the directory you want to work in. You can select a subdirectory 
from your current directory, or you can specify a different directory by its 
pathname. You return to the Manager menu, and the listing for the new 
current directory appears on the screen. 

Creating a new directory 
To create a new directory, select the Directory option from the Manager menu, 
and then select the Make option from the Directory menu. You are now asked 
to enter the name of the new directory. 

Type the name of the new directory, and press (Return). You return to the 
Manager menu, and the new directory appears in the directory listing dis­
played on the screen. 

Removing an empty directory 
Before you can remove a directory, you must make sure that it does not con­
tain any files or subdirectories. If it is not empty, you must either delete the 
files it holds or move them to other directories. 

Once the directory is empty, remove it by selecting the Directory option from 
the Manager menu. Then select the Remove option from the Directory menu; 
you are prompted to select the directory to remove. 

When you have selected the directory, you return to the Manager menu, and 
the directory is removed from the directory listing displayed on the screen. 

Changing directory pennissions 
If you choose the Permissions option in the Directory menu, you can change 
the permissions for the current directory using the Directory Permissions 
form. For more information on this form and how to use it, see the "Changing 
permissions" section earlier in this chapter. 
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The Archive option on the Manager menu provides an easy way to copy files 
to and from BACKUP media (such as floppy disks and tape). It allows you to: 

• display the files currently on the ARCHIVE media 

• extract files from the archive media and place copies into your current 
directory (extracting everything in the archive, or just specific files) 

• create an archive, that is, copy files from your current directory onto the 
archive media 

• format a diskette before archiving files on it 

When you choose the Archive option, the following menu appears: 

~ List Format Create Type Device 
Retrieve files from a disk or tape 
/u/robert Friday April 12, 1991 10:44 

Here are brief descriptions of the Archive menu options: 

Option 

Extract 
List 
Format 
Create 
Type 
Device 

Description 

copies files from archive media into your current directory 
lists all files on the archive media 
formats the archive media to prepare it for copying files 
copies files from your current directory to the archive media 
selects the archive file format: tar, cpio, or DOS 

specifies the address of the disk or tape drive for archiving 

Preparing to use removable media 
Before you use the options in the Archive menu, make sure that your floppy 
disk, tape, or other archive medium is properly mounted. If you do not know 
how to do this, ask your system administrator. 

You must also make sure you know the device address for the tape or disk 
drive you intend to use. For information on device addresses and how to set 
yours, see "Specifying the archive device address" later in this chapter. 

After mounting your archive medium and specifying the device address, you 
need to choose a type of format for archiving. The three available types of for­
mat are tar, cpio, and DOS. Generally, tar is the most useful format. If your 
system does not support the use of tar, use cpio. The DOS format provides 
only limited archive functionality. You can use it to copy files to a single 
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diskette, but it does not support archiving of whole directories, nor does it 
support tape formatting. To carry out your choice of archive format, see 
"Specifying the type of format for archiving" later in this chapter. Once you 
have chosen an archive format, use that format for all future archiving so your 
media are interchangeable. 

The operations that you can perform with the Archive options are discussed 
in the following sections. 

Extracting files from backup media 
The Extract option in the Archive menu copies files from archive media into 
your current directory. 

When you choose the Extract option the Media Extraction form appears . 

.----------Media Extraction--------, 
Device: [/dev/rfd096ds1S 

Extract: i.!!.e. Selected Files 

If you want to extract files from an archiving device other than the default 
one, change the entry in the "Device" field. Otherwise, press (Return) to accept 
the default device. For more information on this choice, see "Specifying the 
archive device address" later in this chapter. 

If you want to copy all files in the archive to the current directory, leave the 
All Files option selected for the "Extract" field and press (Return). Copying 
begins immediately. If more than one volume (one tape or diskette) is 
required for the archive, you see a prompt to insert a second volume. When 
archiving is finished, you automatically return to the Manager menu. 

However, if you want to copy only certain files, select the Selected Files 
option of the "Extract" field. In response, a list of all files on the archive media 
appears on the screen. The list looks similar to the following example. If you 
are listing DOS files, the filenames appear in all uppercase characters. 

Select one or more files for extraction from media. 
/u/robert Friday April 12, 1991 10:44 

W'4 specifications test.results z file 

Use the movement keys to scroll through the list. Select the files you want to 
extract with the (Space) bar, and press (Return) to copy the files into your 
current directory. 
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Listing files on backup media 
Before copying files from archive media to your current directory, you might 
want to see what files the backup media holds .. To do this, select the Archive 
menu's List option. A list appears, showing the files contained on the 
currently mounted archive media. If the list fills more than one screen, use 
the movement keys to scroll through it. If you see a prompt for a second vol­
ume, insert the second diskette or tape that contains the rest of the archive 
you are listing. Note the files that you want to retrieve. When you are 
finished looking at the list, press (Esc) to clear the screen and return to the 
Manager menu. 

Formatting archive media 
Before archiving files, you might have to "format" the diskette or tape that 
you want to archive them on. First make sure you have set your format type, 
as described in "Specifying the type of format for archiving" later in this 
chapter. If you are not sure what format type is used on your system, or if 
you are not sure whether you need to format your media, check with your 
system administrator. If you do need to format the archive media and the 
type is set correctly, choose the Format option on the Archive menu. The 
M~dia Formatting form appears. 

r--------.Media Formatting---------, 
Device: [/dev/rfd096ds15 

Confirm: uM","@ Abort 

If you want to format media on an archiving device other than the default 
one, change the entryin the "Device" field. Otherwise, press (Return) to accept 
the default device. For more information on this choice, see "Specifying the 
archive device address" later in this chapter. 

To confirm your decision to begin the formatting process, press (Return) again. 
Formatting takes a few minutes. When the media is formatted, you return to 
the Manager menu. 

If you decide you do not want to format the media, select the Abort option in 
the "Confirm" field. 

Copying files to backup media 
The Create option copies files from your current directory to the archive 
media. When you select the Create option, the screen displays a list of the files 
in your current directory. Select the file(s) that you want to copy. If you are 
using tar or cpio and you select a directory, all of its contents, including any 
subdirectories and their contents, are transferred onto the archive media. 
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Press (Return) to begin the copying process. If the archive fills more than one 
volume (diskette or tape), you see a prompt to insert a second volume. After 
the files that you selected have been copied to the archive, you automatically 
return to the Manager menu. 

When you make a tar or cpio archive, all existing files on the archive media 
are overwritten. When you make a DOS archive, only those files on the 
archive that have the same name as the files you are copying are overwritten; 
all others remain intact. Keep in mind that you can archive files but not direc­
tories in the DOS format. 

Specifying the type of format for archiving 
The Type option in the Archive menu specifies the format you intend to use 
for archiving. When you select the Type option, the following form appears: 

r 
~-----,Archive Format-----....., 

Type: III cpio DOS l 
Select the archive file format that is best suited to the archiving you intend to 
do. In most cases, tar format is the best choice. See your system administra­
tor if you are not sure which format to select. 

Specifying the archive device address 
The Device option in the Archive menu specifies the address of the device 
driver for the device you intend to use for archiving. When you select the De­
vice option, the following form appears: 

r Archive Device'-----...... 
Device: ["Mail·p"e 11 l 

The ilDevice" field automatically displays the address of the drive that is nor­
mally used for archiving. If you intend to use that drive, just press (Return) to 
accept this entry as is. 
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To see a list of all possible drives on your computer system, press (F3). A box 
appears on the screen with. a list of the devices in the /dev directory on a typi­
cal system; your list might have more or different entries. 

".',!elt:p" 
/dev/rfd096ds15 
/dev/rfd0135ds9 
/dev/rfd0135ds18 
/dev/rctO 
/dev/rctmini 

The names of the devices appear in coded form. According to the conven­
tions of the code, the first letter (r in the sample list) stands for the access 
method; you can usually ignore this letter, as it is the same for most devices. 

The next two letters specify the type of media; fd stands for floppy diskette 
and ct for cartridge tape. The next number (0 for most devices in the sample 
list) is the number of the disk or tape drive. The final characters of the code 
(for example, 48ds9) are size parameters for floppy diskettes. They indicate 
the number of tracks per inch, the number of sides used (ss=single-sided, 
ds=double-sided), and the number of sectors per track. 

The following table indicates the size and type of media associated with each 
drive in the sample list. 

Device Code 

rfd048ds9 
rfd096ds15 
rfd0135ds9 
rfd0135ds18 
rctO 
rctmini 

Size and Type of Archive Media 

5.25 inch 360-Kbyte floppy diskette 
5.25 inch 1.2-Mbyte floppy diskette 
3.5 inch 720-Kbyte micro-floppy diskette 
3.5 inch 1.44-Mbyte micro-floppy diskette 
standard tape drive 
mini-cartridge tape drive 

Choose a drive from this list by highlighting it with the arrow keys and press­
ing (Return). 

The fete/default/tar file on your system must contain valid archive devices for 
your choice to take effect. If you do not know which devices your system sup­
ports, or if you do not know which device to choose, see your system 
administrator. 
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Using the Clipboard from the Manager menu 

The Transfer option on the Manager menu allows you to access the Clipboard 
from seQ Shell. Use Clipboard to transfer information between different 
applications. Once you have put an item on the Clipboard, you can access it 
from any application that contains a Transfer menu. The Transfer menu 
allows you to copy files to the Clipboard that did not come from another 
a pplica tion. 

To use the Clipboard, select Transfer from the Manager menu. A menu like 
the following appears: 

~ Paste Remove Quit 
i'¥!MM 

Copy file(s) to the clipboard 
/u/robert Friday April 12, 1991 10:44 

The four options on the Transfer menu allow you to use the Clipboard from 
the Manager menu. Below is a summary of these options: 

Option 

Copy 
Paste 
Remove 
Quit 

Description 

copies an item to the Clipboard 
pastes an item from the Clipboard to a directory 
deletes an item from the Clipboard 
exits the Transfer menu 

See Chapter 5, "Sharing information among applications," for more informa­
tion about using the Clipboard from the Manager menu. 

Setting preferences for text editing 

The Preferences option lets you customize how you edit text files. When you 
select the Preferences option, the following form appears: 

.--------.Editor Configuration----------, 
Built-in text editor 

Line Length: [fi] 

User selected editor 

Auto Editor: 
File Suffix: 

Save as default? [Yes] No 
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Use the Line Length field to set the default right margin for all use of the 
built-in sea Shell text editor. The default is set to the maximum for your 
screen width; in most cases, this is is 77 spaces. If you want to create a wider 
right margin as you edit text files with the sea Shell editor, enter a smaller 
number in the Line Length field. For example, if you want to create a right 
margin of 10 spaces and your default line length is 77, change the number in 
the Line Length field from 77 to 67. 

Use the Auto Editor field to specify the pathname of an editing program other 
than the built-in sea Shell text editor. For example, enter the path 
/usr/bin/word to use Microsoft Word if your system has Word in this location. 
If you do not know the location of your chosen editor, see your system 
administrator. 

In the File Suffix. field, specify a filename extension that invokes your chosen 
Auto Editor. For example, you can enter dcx if you have specified Microsoft 
Word as your Auto Editor. After you have set these preferences, select the 
Edit option in the Manager menu, then select any Word file with the .dcx 
extension, and you see the text in a Microsoft Word editing window. Files 
that do not have the .dcx extension still invoke the sea Shell text editor. 

If you specify an Auto Editor but leave the File Suffix field blank, sea Shell 
invokes your Auto Editor for all files you select after choosing the Edit option 
in the Manager menu. 

The last field in the form allows you to save your preferences for future sea 
Shell sessions. 

If you make the changes described above, the form looks like the following: 

r--------Editor Configuration---------. 
Built-in text editor 

Line Length: [mil 

User selected editor 

Auto Editor: [/usr/bin/word 
File Suffix: [dcx 

Save as default? [Yes] No 

Exiting the Manager menu 
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Select the Quit option to exit the Manager menu. You return to the sea Shell 
window. 
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Sharing information among 
applications 

Most applications that run under sea Shell are separate programs that can 
stand alone. Yet you can also move data among them as easily as if they were 
one program. This feature is called DATA INTEGRATION. 

This chapter explains data integration in detail, suggests ways in which you 
can use it, and actually shows you how to move data among applications. 

Data integration in seD Shell 
Within the sea Shell environment, the CLIPBOARD performs data integration. 
The Clipboard acts as a storage place and translator. You copy data from an 
application onto the Clipboard, and then paste the data from the Clipboard 
into a different application. To complete a financial report, for example, you 
might use the Clipboard to copy a spreadsheet from a spreadsheet package 
onto the Clipboard; then, you could paste the data into an MS-Word docu­
ment. You can reach the Clipboard from all programs that include the 
Transfer option. 

Using the. Clipboard between applications 

The Clipboard is a feature of sea Shell. You can reach it from almost any 
application through a special Transfer menu. Transfer menus are available 
from sea Shell, sea Portfolio, and MS-Word. 
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As stated earlier, the Clipboard lets you move information from one applica­
tion to another. This is a three-step process: 

1. From within an application, copy data onto the Clipboard. 

2. Start up another application. 

3. From within the other application, paste data from the Clipboard into an 
open file. 

The Clipboard is more than just a simple conduit between programs. You can 
store numerous items in your Clipboard, on either a short- or a long-term 
basis. Items can be of any size. 

Translating information to a new file format 
The Clipboard is "smart" in the way that it handles information. When you 
paste information from the Clipboard into an application, the Clipboard auto­
matically translates the information into the receiving application's file for­
mat. The original copy of the item stays in the Clipboard, still in the original 
file format. 

The only exception is performing Clipboard operations from the sea Shell 
screen. From the sea Shell's Transfer menu, you must specify the current for­
mat of any file you are copying to the Clipboard. There is a good reason for 
this extra step, which is explained later under "Copying data indirectly using 
the Clipboard." 

Accessing the Clipboard 
Each user has an individual Clipboard. No other user can copy items to it or 
paste items from it. You can keep as many items as you want on your 
Clipboard. 

Storing often~used data in the Clipboard 
Once you copy something to your Clipboard, you can paste it to other appli­
cations as often as you like. Clipboard items stay in the Clipboard until you 
specifically remove them. 

Thus, the Clipboard is a good place to store things that you need again and 
again. For example, you might use it for storing ''boilerplate'' text that you 
need to insert repeatedly in reports or other standard documents. 

You should note, however, that the files you copy to the Clipboard are simply 
that: copies. Changes to the original files do not update the copies in the 
Clipboard. 

seQ Shell User's Guide 



Using the Clipboard from sea Shell 

Copying data indirectly using the Clipboard 
You cannot copy data directly from programs that do not support the Clip­
board. There are, however, easy ways to import the data indirectly. 

Most database, spreadsheet, and word processing programs can export data 
from their special file formats into standard text files. You can then use the 
Clipboard from the Manager menu of the sea Shell screen to copy these files 
onto your Clipboard. Then they can be pasted into other sea applications, or 
non-Sea applications that support the Clipboard. 

From the sea Shell screen, you can copy any file in your current directory (or 
any directory that you have access to) onto the Clipboard, not just files that 
are already part of Clipboard-supporting applications. From the sea Shell 
screen, there is no way for the Clipboard to know from which application 
these files are coming. Thus, sea Shell's Transfer menu asks you to specify 
the file format of any files you copy in. This is unnecessary from within other 
sea applications. 

Using the Clipboard from seQ Shell 
This section shows you how to use the Clipboard from sea Shell. 

I NOTE For instructions on using the Clipboard from other applications that 
support it, see the documentation for the appropriate application. 

From the sea Shell's Manager menu, choose the Transfer option. The Transfer 
menu appears: 

~ Paste Remove Quit 
Copy filets) to the clipboard 

/u/robert Friday April 12, 1991 10:48 

The options on this menu allow you to use the Clipboard. Some of the appli­
cations have fewer options on their Transfer menus, but most contain the four 
options shown on this menu. Here are brief descriptions of the options on the 
Transfer menu which are described in the following sections: 

Option 

Copy 
Paste 
Remove 
Quit 

Description 

copies an item to the Clipboard 
pastes an item from the Clipboard to a file 
deletes an item from the Clipboard 
exits the Transfer menu 
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Copying an item to the Clipboard 
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Select the Copy option to duplicate a file to the Clipboard. A list of the files in 
your current directory displays on the screen, and you see the prompt to 
select a file: 

Enter a file to be copied to the clipboard: lulrobertl 

lu/robert Friday April 12, 1991 10:48 

You can now select a file to copy to the Clipboard. Enter the filename at the 
prompt, or highlight it in the File window that appears on the sea Shell 
screen. 

After you make your selection, you are prompted for the FILETYPE of the file 
from which you are copying. The Filetypes box displays on the screen: 

Select the filetxpe yoU are copying from 
"i,,·me .. !!,. .1 I * Text - , 

Other - None Of The Above 

Tell the Clipboard the format of the file that you are copying by selecting a 
type from this box. The Clipboard must know the file's type to translate the 
file correctly when you paste it. 

To select a type, use the arrow keys to move the highlight to the correct type, 
and press (Return). After specifying the Clipboard type, you are asked to 
choose a name for the new clipboard item: 

What is the name of this item: ~ 

lu/robert Frlday Aprll 12, 1991 10:48 

The name you enter here is given to the copy of the file that is placed on the 
Clipboard. (The name of the original file does not change.) The default name 
is temp. If you want to use the default name, simply press (Return). To give 
the item a different name, type the name and press (Return). 
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Each time you select temp as the clipboard item name, the Clipboard 
overwrites the previous temp item. Consequently, it is a good idea to select 
unique names for clipboard items, especially if you want to save them. 

When you have named the clipboard item, the copy process is complete, and 
you return to the Transfer menu. 

Pasting an· item from the Clipboard 

The Paste option allows you to take an item from the Clipboard and PASTE it 
into a file. You can translate the item to a different type when you paste it. 

When you select the Paste option from the Transfer menu, the Clipboard File­
types box displays on the screen: 

Select the filetype~OU are pasting to 
§!"i.in-!!!!!!!'- • • * Text -

Other - None Of The Above 

You must now pick a file format. The clipboard item that was previously 
copied to the Clipboard is translated into this format when you paste it to a 
file. To choose a format, use the arrow keys to move the highlight to the one 
you require, and press (Return). If you wanted to move a spreadsheet into a 
text file, for example, you would highlight Text here. 

Once you have chosen the file format, the Clipboard displays a list of all the 
current clipboard items that it can translate into that type. (The list may not 
include every item on the Clipboard, because some file conversions are 
impossible.) They will be displayed in a box like this: 

,-----------Clipboard Items------------, 
* boilerplate figl SCO Shell 

text.mine 
wordl 

tmp 
wordfile 

seo shell 
Word 

The box's left-hand column holds the name you gave the item when you 
copied it to the Clipboard. The middle column holds a description of the 
item: in some cases, the description is the filename this item had when it was 
copied to the Clipboard. The right-hand column holds the name of the appli­
cation from which the clipboard item was copied. 
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To select the item to paste, use the arrow keys to move the highlight to the 
item you require, and press (Return). This line displays at the top of the 
screen: 

Enter new filename: /u/robert/ 

/u/robert Friday April 12, 1991 10:49 

The current directory is shown at the top of the screen. You are asked to enter 
a new filename for the item you are pasting. The name of the original item is 
not changed, and it remains on the Clipboard. You can paste an item as many 
times as you want. After you enter a name, you return to the Transfer menu. 

Deleting an item from the Clipboard 
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To delete an item(s) from the Clipboard, select the Remove option from the 
Transfer menu. The Clipboard Items box then appears: 

"' ____ iiiiiiiiiiiiiiiiiiii ___ eliPboar~daIEtiemis.iiiiiiiiiiiiii.1 ·WerM "'iM' text.mine tmp seQ Shell 
word! wordfile Word 

This box lists all the items on the Clipboard that can be removed. 

To select the item you want to remove, use the arrow keys to move the 
highlight to that item, and press (Return). The item is deleted from the Clip­
board, and you return to the Transfer menu. 
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Printing 

From sea Shell, you can print a copy of any file that you own. You can also 
change to a different printer, check the status of print jobs that you have 
already sent out, and cancel print jobs that are in progress. 

Using the Print menu 

To print a file, select Print from the sea Shell menu. You see the following 
menu: 

Current printer: lp 

E Select PrintStatusCancel Quit 
Send filers) to the current printer 
/u/robert Frlday Aprll 12, 1991 11:44 

The following are brief descriptions of the Print menu items: 

Option 

Go 
Select 
PrintStatus 
Cancel 
Quit 

Description 

sends one or more files to the current printer 
chooses a different printer 
checks the status of your print jobs 
cancels a print job 
returns to the sea Shell menu 

The following sections describe these options. 
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Sending files to the printer 

Select the Go option to send one or more files to the current printer. When 
you select Go, a list of the files in your current directory displays on the screen 
along with this message: 

Current printer: lp 

Enter file(s) to print: /u/robert/ 
/u/robert Friday April 12, 1991 11:45 

Now you can select the file(s) that you want to print. If you are not sure how 
to do this, see the section "Selecting files" in Chapter 4, "Managing your files". 
The files that you select are sent to the current printer, and you return to the 
Print menu. 

Selecting a different printer 
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To send your file(s) to a different printer, choose Select from the Print menu. 
With this option, you can select a different printer just for your current sea 
Shell session, or you can change the default that is used whenever you start 
sea Shell. 

When you choose the Select option, a box similar to the following displays on 
your screen: 

.----------Printer Select----------. 
* default (Default prlnter) 

laser2 
laser2.land 
laserjet 
lp 

(HP LaserJet Series 2 with native fonts) 
(HP LaserJet Series 2 in landscape mode) 
(HP LaserJet with native fonts) 
(Default Printer) 

To select a printer, move the highlight to the printer name that you require 
and press (Return). A new box appears on the screen asking if you want this 
printer to be saved as the default printer. If you select Yes, the printer you 
have selected becomes the default printer which is used as the current printer 
whenever you start sea Shell. If you select No, the selected printer is the 
default printer for the current sea Shell session only. 
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Checking the status of print jobs 

To check on the progress of a print job, choose PrintStatus from the Print 
menu. A box similar to the following displays on your screen: 

r----------,Print Status----------, 
Printer1-82 
Printer1-83 

robert 5798 Apr 12 11:24 on printer1 
robert 20481 Apr 12 11:29 on printer1 

Each line in this box corresponds to a print job. Every line tells you the name 
of the printer the job is going to, the number of the print job, the login name of 
the person who sent the job, the number of characters in the file, and the date 
and time that the print job was sent. Press (Esc) to remove the box from the 
screen and return to the Print menu. 

If there are no current print jobs, sea Shell displays a message to that effect at 
the bottom of the screen. Press (Return) to return to the Print menu. 

Canceling print jobs 

To interrupt a print job, select the Cancel option from the Print menu. When 
you select Cancel, a box similar to the following displays on the screen: 

r---___ ------Print Status-----------, 
Printer1-82 robert 5798 Apr 12 11:24 on printer1 
Printerl-83 robert 20481 Apr 12 11:29 on printer1 

Move the highlight to the job(s) that you want to cancel and press (Return). 
After you cancel the job(s), you automatically return to the Print menu. 

If there are no current print jobs, you see a message to that effect. Press 
(Return) to return to the Print menu. 

Exiting the Print menu 

To exit the Print menu and return to the sea Shell menu, select the Quit 
option from the Print menu. 
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Configuring your sea Shell 
environment 

sea Shell provides a versatile working environment that you can configure to 
suit your personal needs. You can change the following: 

• You can alter the windows displayed on the sea Shell screen to fit your 
preferences by changing the size of the windows, their positions on the 
screen and, in some cases, the format in which they display information . 

• You can add, delete, or change the order of programs on the Application 
and Utility menus. 
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This chapter explains in detail how to make these changes. When you start 
sea Shell, you see the main sea Shell screen first. The default sea Shell 
screen looks like this: 

snrt""!!§b Manager Print Utility Options Quit 
Select an application 
/u/robert Friday April 12, 1991 10:42 

Mail - Electronic Mail 
System - Run a System Shell 

.. / clipdir/ 
News! memo.goodbye 
wastebasket! memo. lunch 
announcement memo.meeting 
annual. report memo. review 
cash. advance memo. salary 
deadlines memo. specs 

memo.budget 

Apr 1991 
S M Tu W Th F S 

1 2 3 4 5 6 
7 8 9 10 11 1113 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 

performance 
report.expense status.2.12 
report.hires status.2.12 
report.plan status.2.26 
report.sales status.2.26 
report.space status.3.11 
specif ications 

If you are unfamiliar with any parts of this screen, see Chapter 2, "Getting 
started with sea Shell." 

Using the Options menu 
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To modify the seQ Shell environment, select Options from the sea Shell 
menu. The Options menu displays: 

II1II Applist Utillist Save Quit 
Configure desktop display 
!u/robert Friday, April 12 1991 10:44 
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Here are brief descriptions of the selections on the Options menu: 

Name Description 

configures the seQ Shell screen's windows Display 
Applist edits the applications list and selects the first application 

displayed 
Utillist 
Save 
Quit 

edits the utilities list 
saves the seQ Shell screen configuration 
returns to the seQ Shell menu 

Each of these options is discussed in detail in the following sections. 

Changing the seD Shell screen display 
To change the way the seQ Shell screen looks, the positioning of each win­
dow, and how the information is displayed inside the windows, select Dis­
play from the Options menu. This calls up the Display menu, which lets you 
choose one of the following items: 

Name 

FileWindow 
AppWindow 
CalendarWindow 
Quit 

Description 

configures the File window display 
configures the Application window display 
configures the Calendar window display 
returns to the Options menu 

The procedures for configuring the different display windows are very simi­
lar. The following section explains the basic procedure that applies to all of 
the windows. After that, the details that are unique to each window are 
covered. 
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Basic procedure 
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After you have selected one of the four Display menu items, a reconfiguration 
form pops up in the middle of the screen. The following table describes the 
reconfiguration form fields that are common to all window displays. 

Name 

Full 
Top 
Bottom 
Left 
Right 
Quarter 
Off 

Description 

displays the window full screen 
displays the window in the top half of the screen 
displays the window in the bottom half of the screen 
displays the window in the left half of the screen 
displays the window in the right half of the screen 
displays the window in one quarter of the screen 
turns the window display off 

The first five menu items (Full, Top, Bottom, Left, and Right) describe specific 
areas of the display screen. If you select the next item, Quarter, the cursor 
moves to the Quarter line. Indicate the quarter of the screen in which you 
want the window to appear by selecting 1,2,3, or 4. The following illustra­
tion shows how the quarters are divided: 

1 2 

3 4 

If you select Off, the window is no longer displayed on the screen. However, 
it reappears if you call up its corresponding application by making a menu 
selection or pressing its assigned function key. 
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To implement the new window configuration and return to the sea Shell 
menu, press (Return) on the last line of the form. To save this configuration as 
the new default for sea Shell, see "Saving the sea Shell screen configuration" 
later in this chapter. If you save the changes as the new default, there is no 
easy way to revert back to the original default, and you can only restore the 
original settings by redefining them yourself. If you do not save the changes, 
the sea Shell's display returns to its default configuration the next time you 
start it. 

The following sections provide details for reconfiguring the different window 
displays. 

Configuring the File window 

The File window displays a listing of the files in the current directory. You 
can change its configuration in the same way you change other windows. 

After you choose the FileWindow option from the sea Shell menu, this form 
appears: 

.----------File Display------------. 

Display: 

Style: 
Sort By: 
Order: 

Full Top ~ Left Right Quarter Off 
Quarter: [1] 2 3 4 

[Brief] System 
[Alpha] Date 
[Ascending] Descending 

See "Basic procedure" earlier in this chapter for details about the "Display" 
field. Note that if you select Off, the File window still appears when you 
choose File from the sea Shell menu. The only difference is that the pathname 
to your current directory does not appear in the divider line when the File 
window is turned off. 

The "Style", "Sort By", and "Order" fields indicate how to display the 
filenames within the File window. 

In the "Style" field, choose Brief to display only the filenames. Brief is the 
default. The System option displays the filenames with more detailed infor­
mation. You can see this information in all displays other than the Quarter 
screen display. The following is a sample of a system display of a file: 

mbox -rw-r--r-- 1 robert sales 9499 04/12/91 12:02 

The System listing displays (in order of appearance): filename; read, write, 
and execute permissions;. number of links; owner of the file; group the owner 
belongs to; number of characters in the file; date; and time the file was created 
or last modified. See Chapter 4, ''Managing your files," for. a complete expla­
nation of each of the elements in the system file listings. 
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In the "Sort By" field, choose Alpha to sort the filenames alphabetically by the 
first letter in each name, or choose Date to sort the filenames by the date the 
file was created or last modified. By default, directories are listed first, 
whether the filenames are sorted alphabetically or by date. 

In the "Order" field, choose Ascending to display the filenames in ASCENDING 

ORDER. If the filenames are sorted alphabetically, the order in which they are 
displayed is "A-Z". If the filenames are sorted by date, they are displayed 
with the most recently created or modified file first. Choose Descending to 
display the filenames in DESCENDING ORDER. If the filenames are sorted alpha­
betically, the order in which they are displayed is "Z-N'. If the filenames are 
sorted by date, they are displayed with the most recently created or modified 
file last. Directories are always displayed first in the File window. 

Configuring the Application window 
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The Application window displays a listing of the applications currently avail­
able from sea Shell. It displays by default in the top left quarter of the sea 
Shell screen. 

After you have selected AppWindow from the Display menu, this form 
appears: 

.---------.Application Display---------, 

Display: Full Top Bottom Left Right ~ Off 
Quarter: (1] 2 3 4 

Style: Brief (Detailed] 

See "Basic procedure" earlier in this chapter for details about the "Display" 
field. 

In the "Style" field, choose Brief if you want to display only the names of the 
applications, or Detailed if you want descriptions to accompany the names. If 
you do not specify a choice, the detailed display appears by default. 

The following is an example of a detailed display: 

Mail - Electronic Mail 
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Configuring the Calendar window 

The Calendar window displays the current month, with a highlight over the 
current date. It is located by default in the bottom right corner of the seQ 
Shell screen. 

After you have selected the CalendarWindow option from the Display menu, 
this form appears: 

.---------Calendar Display·-----__ --. 

Display: Full Top Bottom Left Right ~ Off 
Quarter: 1 [2] 3 4 

See "Basic procedure" earlier in this chapter for details about the "Display" 
field. 

Returning to the Options menu 

To return to the Options menu, select Quit from the Display menu. 

Saving the seD Shell screen configuration 

To save the new display configuration and return to the seQ Shell menu, 
select Save from the Options menu. When you select Save, the next time you 
use seQ Shell, this new configuration is the default. If you save the changes as 
the new default, there is no way to revert back to the original default, and you 
can only restore the original settings by redefining them yourself. 
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Editing the Applications list 
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You can use the Applist option to add, change, delete, or move programs and 
application folders on the Applications list. 

When you select Applist from the Options menu, the list of applications and 
application folders that appears on the sea Shell screen displays. The default 
Applist window provided by this version of sea Shell looks like this: 

~ Edit Delete Undelete Switch Quit 
Add a command or folder to your list 
pplication List for robert Friday Aprll 12, 1991 11:17 

Type . Name 

Mail 
System 

Description 

- Electronic Mail 
- Run a System Shell 
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The following table summarizes the six Applist menu options: 

Option 

Add 

Edit 

Delete 

Undelete 

Switch 

Quit 

Description 

adds a new command or folder to the list. You can select a 
command or folder from the list of those available to all sea 
Shell users on your system or you can choose to create a new 
command or folder. 

When you add a command, you can direct sea Shell to start 
it automatically. You can also direct sea Shell to display this 
application first when you enter sea Shell. 

edits an existing listing for a command or folder. 

removes a command or folder from the list 

restores a previously deleted command or folder to the list. 
This option is useful for moving listings between folders. 

switches to another application folder. The listings in this 
folder are now available for editing using the options on the 
Applist menu. 

returns to the sea Shell menu 

These options are described in more detail in the following sections. 

Adding a default listing 

The first time you make any changes to the default Applications list, sea Shell 
creates a personal Applications list for you by adding a file called .appllist2 to 
your home directory. 

If you are using a personal Applications list, a command or folder added to 
the default Applications list is not added to your personal .appllist2 file and, 
therefore, does not appear on your personal list. Before you can use a new 
command or folder, you must add a listing to your Applications list if you are 
using a personal Applications list. 

If you have a personal Applications list and you want to return to using the 
default list, you must remove (or rename) the .appllist2 file from your home 
directory. 

Additionally, you might wish to add an application or application folder that 
is not on the default list to your personal list. This procedure is described in 
the next section, II Adding a new listing." 
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To add a listing to your Applications list from the default Applications list: 

1. Select the Add option from the Applist menu. 

2. Choose the Select option from the Add menu. A window with the avail­
able applications and folders pops up over the screen, and looks similar to 
this: 

Select commands or folders to add to your list 
ppllcatlon Llst for robert Friday Apr 12, 1991 11:04 

Type Name 

Mail 
System 

Description 

- Electronic 
- Run a system Shell 

r-----Addin~ items ." ...... , .. * Mail -
System - Run a System Shell 
Shell - C Shell 
Shell - Korn Shell 
Accounts ... - Accounting Package 
General - General Ledger 
AR - Accounts Receivable 
AP - Accounts Payable 
Cost - Cost Accounting 
Payroll - Payroll 
MS-Word - Word Processor 
Professional - Spreadsheet 

The list on the left side of the screen shows the applications and folders 
that are currently accessible on your Applications list. The list on the right 
shows the applications and folders available on the system. Folders are 
indicated by three dots ( ... ) after their name. Your display might look 
different from the example, depending on the applications currently avail­
able on your system. 

3. To select an application or folder from the window at the right and add it 
to your personal Applications list, move the highlight over the application 
or folder to add and press (Return). You can select more than one applica­
tion by moving the highlight to each of the desired applications and press­
ing (Space). The" *" character appears next to the selected applications. 
Press (Return) to add all the marked applications to the Applications list. 

For example, on the screen shown above, you could move the highlight to 
the listing for the Accounts folder and press (Space). If you do the same for 
the Payroll and Cost applications and then press (Return), you select all 
three of these items. 
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4. You are prompted to specify whether to add the item(s) to the beginning 
of the existing list, to the end of the list, or to another location in the list. 
To identify the location, select Choose, and the current list is displayed 
with a highlight. Move the highlight to the item above the chosen location 
and press (Return) to put the marked listing(s) in this position. 

In the example with the Accounts folder and the Payroll and Costs applica­
tions, you can add these to the main Applications list below the listing for 
Mail by selecting Choose, moving the highlight to the Mail listing, and then 
pressing (Return). The next time you display the main Applications list, it 
looks like the following: 

·e. 
/u/robert Friday Apr 12, 1991 10: 44 

Mail - Electronic Mail 
ccounts ... - Account~ng Package 

System - Run a System Shell 

.. / clipdir/ memo.budget 
News/ memo.goodbye report. expense 
wastebasket/ memo. lunch report.hires 
announcement memo.meeting report.plan 
annual.report memo.review report. sales 
cash.advance memo. salary report. space 
deadlines memo. specs specifications 

Apr 1991 
S M Tu W Th F S 

1 2 3 4 5 6 
7 8 9 10 11 II 13 

14 15 16 17 18 19 20 
21 22 23 24 25 26 27 
28 29 30 31 

performance 
status.2.12 
status.2.12 
status.2.26 
status.2.26 
status. 3.11 

You can add an item to the list in an application folder by first switching to 
the folder using the Switch option on the Applist menu. This option is 
described later in "Switching to another Application folder." 
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Adding a new listing 
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To create a listing for a new folder or an application, you must create a listing 
in your personal Applications list. 

I NOTE Adding the application or folder to your personal list makes it avail­
able only to you, and does not change the list of applications available to the 
other users on the system. 

To create a new listing, follow these steps: 

1. Choose the Add option from the Applist menu. 

2. Choose the Create option. 

3. If you want to create an application, choose Command. The following 
form displays: 

.----------'Creating command----------. 
Name: 1 
Description: 
Path Name: 

If you want to create an application folder, choose Folder. This form dis­
plays: 

.-----------Creating folder'--------. 
Name: 1 
Description: 

4. Add the information for the new application or folder to the form. The 
following table describes the information required in each field: 

Field 

Name 

Description 

Path Name 

Enter 

name of the application or folder as it appears on the 
Applications list 
description of the application or folder as it will appear 
on the Applications list 
pathname of the file used to invoke the application. This 
must be an existing file. 

5. Now press (Return) or (Ctrl)x on the last field to get back to the Applist 
menu. 
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6. You are prompted to specify whether you want to add the item(s) to the 
beginning of the existing list, to the end of the list, or to another location in 
the list. If you select Choose, the current list displays with a highlight. 
Move the highlight to the item· above the chosen location and press 
(Return) to put the new listing in this position. 

7. To save the new application or folder, select Quit ¢ Yes to leave the 
Applist menu. Your personal Application list appears with the new appli­
cation or folder added to it. If you decide not to save your new applica­
tion or folder, select Quit ¢ Abandon. 

Editing an Application listing 

To change an item that is already on the Applications list, select the Edit 
option from the Applist menu. With this option, you can: 

• change the name of an application or folder 

• change the description of an application or folder 

• change the pathname of the program that is invoked when the application 
is selected 

To change an item on the Applications list: 

1. Select the Edit option from the Applist menu. The existing listings display 
on a screen like this: 

Select command or folder to edit 
pplication List for robert Friday Apr 12, 1991 10:42 

Type Name Description 

* Mail - Electronic Mail 
System - Run a System Shell 

2. Move the highlight to the item that you want to edit and press (Return). 
The following form pops up if the item that you chose is an application 
(the information for Mail is displayed in this example): 

.----------Editing command---------"I 
Name: [III ] 
Description: [Electronic Mail 
Path Name: [/usr/bin/mail 
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If the item that you chose is a folder, the following form pops up (the in­
formation for an Accounts folder is displayed in this example): 

r:=:-:------; __ ~Editing folder----------, 
Name: [1-,,3.",," 1 
Description: [Accounting Package 

3. Edit the pertinent fields to change the information for the selected applica­
tion or folder. The following table describes the information required in 
each field: 

Field 

Name 

Description 

Path Name 

Description 

the name of the application or folder, as it appears on the 
Applications list. To change this name to Email, for 
example, change the text in the "Name" field. 
the description of the application or folder, as it appears 
on the Applications list. To change the description to 
"Online mail", for example, change the text in the 
"Description" field. 
the pathname of the file used to invoke the application. If 
you enter a new pathname, the specified directories and 
filename must already exist To change the pathname to 
/usr/bin/mail, for example, change the text in the "Path 
Name" field. 

If you make all of the example changes in the table, the form looks like the 
following: 

...---'---------Editing command.---------, [III 1 Name: 
Description: [Online Mail 1 
Path Name: [/usr/bin/mail 

4. Press (Return) or (Ctrl)x on the last field to update the application or folder 
listing and return to the Applist menu. When you select Quit ¢ Yes to 
leave the Applist menu, the changes that you made are saved. If you 
decide not to save the changes, select Quit ¢ Abandon. 
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Removing an Application listing 

To remove a listing from the Applications list, follow these steps: 

1. Select Delete from the Applist menu. The existing listings display on a 
screen like this: 

-Select commands or folders to delete 
ppllcatlon Llst for robert Frlday Apr 12, 1991 10:47 

Type Name Description 

* Mall - Electronlc Mail 
System - Run a System Shell 

2. Mark one or more listings by pressing (Space) to select them, and press 
(Return). For example, you can mark Shell for deletion from the screen 
shown above. 

3. You are asked to verify the requested deletions. Select Yes to remove the 
listing(s). The Application window is updated and you return to the 
Applist menu. Select No to return to the Applist menu without removing 
the listing(s). 

If you delete Shell, the next time you display the Applications list, this item is 
not included. 

Restoring an Application listing 

If you delete an application listing by mistake, use the Undelete option to 
restore it. You can also use the Undelete option to change the order in which 
applications and folders are displayed in an Applications list or to move items 
between folders. 
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1. Choose the Undelete option from the Applist menu. A list of the deleted 
applications and folders displays: 

"'P' Select commands or folders to undelete 
pplicatlon List for robert Friday Apr 12, 1991 10:49 

Type Name Description 

* System-
Undeletinq items 

ri ... ••• .. ,,· 

2. Move the highlight bar to the item that you want to undelete, and press 
(Return). You can select more than one application or folder to undelete by 
moving the highlight to each of the desired listings and pressing (Space). 
The" *" character appears to the left of the selected listings. 

For example, you can mark the Shell listing on the screen shown above. 

3. When you have selected one or more applications or folders to undelete, 
you are prompted to restore the item(s) to the beginning of the existing 
list, to the end of the list, or to another location in the list. If you select 
Choose, the current list displays with a highlight. Move the highlight to 
the item above the chosen location and press (Return) to put the marked 
listing(s) in this position. 

If you undelete Shell, the next time you display the Applications list, Shell 
is included. 

I 
NOTE seQ Shell "remembers" deleted applications and allows you to 
restore them only while you are still in the Applist menu. Once you leave 
the Applist menu, you cannot restore the deleted items with Undelete. 
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Switching to another Application folder 

Use the Switch option on the Applist menu to switch to another application 
folder. You can then 'configure the contents of the new folder. 

1. Choose the Switch option from the Applist menu. A list of all existing 
, folders displays. 

2. Select one of the folders, and its contents are displayed. 

The contents of the new folder are displayed as the current applications 
list until you switch to another folder or leave the'Applist menu. 

For example, you can switch to the Accounts folder, choose Switch from the 
Applist menu, and select Accounts from the displayed list. The Accounts 
applications list becomes the new current list. You can use the Add option to 
add General Ledger, Accounts Receivable, and Accounts Payable to the list. 
You can also use the Undelete option to add the previously deleted Cost 
Accounting and Payroll listings. 

Returning to the seD Shell menu 

To return to the sea Shell menu, select Quit from the Applist menu. The fol­
lowing menu options display: 

~ No Abandon 
Save changes and exit 
pplication List for robert Friday April 12, 1991 10:49 

Saving changes to the Applications list 
To save the changes that you made during the current session, select Yes from 
the Quit menu. The Application window displays the new list of available 
applications, and you return to the Options menu. 

Returning to the Applist menu 
To cancel your quit request and return to the Applist menu, select No from 
the Quit menu. The Applist menu then displays. 

Exiting the Applications list without saving changes 
To exit from the Applist menu without saving your changes, select Abandon 
from the Quit menu. The Applications list remains unchanged, and you 
return to the Options menu. 
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Editing the Utilities list 
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You can add, change, delete, or move utilities and utility folders on sea 
Shell's Utilities list using the Utillist option. 

When you select Utillist from the Options menu, you see a screen that looks 
similar to this: 

~ Edit Delete Undelete Switch Quit 
Add a command or folder to your list 
tlllty List for robert Friday April 12, 1991 11:19 

Name 

List Users 
Compare 
Find 
Search 
Usage 
Disk Free 
Kill 
Processes 
All Procs 
OS Version 
Set Colors 

Description 

- Who is Logged on 
- Compare Files 
- Locate A File 
- Text Search 
- Disk Usage 
- Space Available 
- Kill A Program 
- List My Processes 
- List All Processes 
- Print OS Info 
- Application Colors 

The six Utillist menu options are summarized in the following table: 

Option 

Add 

Edit 
Delete 
Undelete 
Switch 

Quit 

Description 

adds a new utility or folder to the list. You can select a 
utility from the list of those available to all sea Shell 
users on your system or you can choose to create a new 
utility listing. 
edits an existing listing for a utility or utility folder 
removes a utility or folder from the list 
restores a previously deleted utility or folder to the list 
switches to another utility folder. You can now 
configure the listings there. 
returns to the sea Shell menu 
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Adding a utility 

The first time you make any changes to the default Utilities list, sea Shell cre­
ates a personal Utilities list for you by adding a file called .utillist2 to your 
home directory. 

If you are using a personal Utilities list, a utility or utility folder added to the 
default Utilities list is not added to your personal .utillist2 file and, therefore, 
does not appear on your personal list. Before you can use a utility or utility 
folder, you must add a listing to your Utilities list if you are using a personal 
Utilities list. Note that if you have a personal Utilities list and you want to 
return to using the default list, you must remove the .utillist2 file from your 
home directory. . 

To add a listing to the Utilities list: 

1. Select the Add option from the Utillist menu. 

2. Choose the Select option. A window with the available utilities and fold­
ers pops up over the screen, and looks similar to this: 

tihty List for robert" Friday April 12, 1991 10: 42 

Name Description 

- Who is Logged on ~. • ~ "'11 List Users 
Compare 
Find 
Search 
Usage 

- Compare Fil * Llst Users - Who is Logged On 

Disk Free 
Kill 
Processes 
All Procs 
OS Version 
Set Colors 

- Locate A Fi Compare 
- Text Search Find 
- Disk Usage Search 
- Space Avail Usage 
- Kill A Prog Disk Free 
- List My Pro Kill 
- List All Pr Processes 
- Print OS In All Procs 
- Application OS Version 

Set Colors 

- Compare Files 
- Locate A File 
- Text Search 
- Disk Usage 
- Space Available 
- Kill A Program 
- List My Processes 
- List All Processes 
- Print as Info 
- Application Colors 

The list on the left side of the screen shows the utilities and folders that are 
currently accessible through sea Shell. The list on the right shows utilities 
and folders that are available but have not necessarily been added to sea 
Shell's Utilities list yet. If you want to use them, you must first add them 
to the list. 
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3. To select a utility from the window at the right and add it to your personal 
Utilities list, move the highlight over the selection you want and press 
(Return). 

You can select more than one utility by moving the highlight to each of the 
desired utilities and pressing (Space). The" *" character appears next to 
the selected utilities. Press (Return) to add all the marked items to the Util­
ities list. 

4. After you have selected the item(s) that you want to add, you are 
prompted to specify whether you want to add the item(s) to the beginning 
of the existing list, to the end of the list, or to another location in the list. If 
you select Choose, the current list is displayed with a highlight. Move the 
highlight to the item above the chosen location and press (Return) to put 
the marked listing(s) in this position. 

You can add an item to the list in a utility folder by first switching to the 
folder using the Switch option on the Utillist menu. This option is described 
later in "Switching to another Utility folder." 

Adding a new Utility listing 
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Select the Add option from the Utillist menu to add a new utility or folder to 
sea Shell and to your personal Utilities list. 

I 
NOTE Adding the utility or folder to your personal list only makes it avail­
able to you, and does not change the list of utilities available to the other 
users on the system. 

To create a new listing, follow these steps: 

1. Choose the Add option from the Utillist menu. 

2. Choose the Create option. 

3. To create a utility, choose Command. The following form displays: 

.--------,Creating command.--------. 
Name: 1 
Description: 
Path Name: 
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To create a utility folder, choose Folder. You see this form: 

....--------ICreating folder-----------. 
Name: 1 
Description: 

4. Add the information for the new utility. or folder to the form. The follow­
ing table describes the information required in each field: 

Field 

Name 

Description 

Path Name 

Enter 

The name of the utility or folder as you want it to appear 
on the Utilities list. 
The description of the utility or folder as you want it to 
appear on the Utilities list. 
The pathname of the file used to invoke a utility. This 
must be an existing file. 

5. To return to the Utillist menu, press (Return) or (Ctrl)x on the last field of 
the form. 

6. You are prompted to add the new listing to the beginning of the existing 
list, to the end of the list, or to another location in the list. If you select 
Choose, the current list is displayed with a highlight. Move the highlight 
to the item above the location where you want to put the listing and press 
(Return) to place the new listing there. 

7. To save the new utility or folder, select Quit ¢ Yes to leave the Utillist 
menu. Your personal Utilities list appears with the new utility or folder 
added to it. If you decide not to save your new utility or folder, select 
Quit ¢ Abandon. 

Editing a Utility listing 

Selecting the Edit option from the Utillist menu lets you change an existing 
utility or utility folder's name, description, or pathname. 

To change an item on the Utilities list: 

1. Select the Edit option from the Utillist menu. 

87 



Configuring your sea Shell environment 

88 

2. Specify whether you want to edit a utility listing (Command) or a folder 
(Folder) listing. Then, a list of the available utilities appears: 

Select command or folder to edit 
tility List for robert Friday April 12, 1991 11:19 

Name Description 

* List Users - Who is Logged on 
Compare 
Find 
Search 
Usage 
Disk Free 
Kill 
Processes 
All Procs 
OS Version 
Set Colors 

- Compare Files 
- Locate A File 
- Te;.:t Search 
- Disk Usage 
- Space Available 
- Kill A Program 
- List My Processes 
- List All Processes 
- Print OS Info 
- Application Colors 

3. Move the highlight to the item that you want to edit and press (Return). 
The following form pops up if the item that you chose is a utility (in this 
example, the information for the List Users utility is displayed): 

r-::~------~RiiftiiE~dlij'ting command-------------------, 
Name: [IF.I'-Hi-] 
Description: [Who is logged on ] 
Path Name: [$OALIB/utils/oawho 

If the item that you chose is a folder, the following form pops up: 

Editinq folder 
Name: @IIID'''¥ ] 
Description: [Word Processing Utilities] 
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4. Edit the pertinent fields to change the information for the selected utility 
or folder. The information required in each field is shown in the following 
table: 

Field 

Name 

Description 

Path Name 

Description 

the name of the utility or folder as you want it to appear 
in the Utilities list 
the description of the utility or folder as you want it to 
appear on the Utilities list 
the pathname of the program that is invoked when you 
select the utility. If you enter a new pathname, the 
specified directories and filename must already exist. 

5. Press (Return) or (Ctrl)x on the last field to update the utility or folder list­
ing and return to the Utillist menu. When you select Quit ¢ Yes to leave 
the Utillist menu, the changes that you made are saved. If you decide not 
to save the changes, select Quit ¢ Abandon. 

Removing a listing from the Utility window 

Use the following procedure to remove a listing from the Utilities list: 

1. Select Delete from the Utillist menu. The existing listings appear on a 
screen like this: 

Select commands or folder to delete 
tility List for robert Friday April 12, 1991 11:20 

Name Description 

* Llst Users - Who is Logged on 
Compare 
Find 
Search 
Usage 
Disk Free 
Kill 
Processes 
All Procs 
as Version 
Set Colors 

- Compare Files 
- Locate A File 
- Text Search 
- Disk Usage 
- Space Available 
- Kill A Program 
- List My Processes 
- List All Processes 
- Print as Info 
- Application Colors 
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2. Press (Space) to mark one or more listings and press (Return) to select them. 

3. You are prompted to verify the requested deletions. Select Yes to remove 
the listing(s). sea Shell updates the Utilities list and returns you to the 
Utillist menu. Select No to return to the Utillist menu without removing 
the listing(s). 

Restoring a Utility listing 

If you remove a listing by mistake, use the Undelete option to restore it. You 
can also use Undelete to change the order in which sea Shell displays utilities 
and folders in a Utilities list. 

1. Choose the Undelete option from the Utillist menu. You see a list of the 
deleted utilities and folders. 

2. Move the highlight bar to the item that you want to restore, and press 
(Return). You can select more than one utility or folder to restore by mov­
ing the highlight to each of the desired listings and pressing (Space). The 
" * " character appears next to the listings you select. 

3. Once you select one or more utilities or folders to undelete, you are 
prompted to restore the item(s) to the beginning of the existing list, to the 
end of the list, or to another location in the list. If you select Choose, the 
current list is displayed with a highlight. Move the highlight to the item 
above the location where you want to insert the restored listing and press 
(Return) to put the marked listing(s) there. 

The next time you display the Utilities list, sea Shell includes the restored 
items. 

I 
NOTE sea Shell "remembers" deleted utilities and makes them available to 
resto.re only while you are still in the Utillist menu. Once you leave the Util­
list menu, you cannot use the Undelete option to restore the deleted items. 

Switching to another Utility folder 
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Use the Switch option on the Utillist menu to switch to another utility folder. 
You can then configure the contents of the new folder. 

1. Choose the Switch option from the Utillist menu. You see a list of all exist­
ing folders. 

2. Select one of the folders, and its contents appear for you to work with. 

The contents of the new folder are displayed as the current Utilities list 
until you switch to another folder or leave the Utillist menu. 
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Returning to the seQ Shell menu 

Returning to the seD Shell menu 

To return to the sea Shell menu, select Quit from the Utillist menu. You see 
the following menu options: 

II No Abandon 
Save changes and exit 
tillty List for robert Friday April 12, 1991 10:50 

Saving changes to the Utilities list 
To save the changes that you made during the current session, select Yes from 
the Quit menu; you return to the sea Shell menu. When you select Utility 
from the sea Shell menu, the Utilities window displays the new list of avail­
able utilities. 

Returning to the Utility list menu 
To cancel your quit request and return to the Utillist menu, select No from the 
Quit menu. You see the Utillist menu. 

Exiting the Utilities list without saving changes 
To exit the Utilities list without saving your changes, select Abandon from the 
Quit menu; you return to the sea Shell menu. 

Returning to the seD Shell menu 
To return to the sea Shell menu, select Quit from the Options menu. 
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Appendix A 

Keystroke commands 

The tables that follow list all keystroke commands that work with sca Shell. 
They include commands that: 

• move the cursor or highlight while editing, or when in sca Shell forms or . 
point-and-pick lists 

• insert or delete text from forms 

• perform all other functions 

Many keystroke commands combine the use of two keys: that is, the (Ctrl) key 
and an alphabetic key on the keyboard. You hold down the first key while 
you press the second. For example, to use (Ctrl)a, hold down the (Ctrl) key 
while you type the letter a. 
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Cursor movement commands 

Keystroke 

(Ctrl)b 

(Bksp) 

(Ctrl)h 

(Ctrl)g ~ 

(Ctrl)p 

(Ctrl)l 

(Ctrl)g ~ 

(Ctrl)n 

(Ctrl)i 

(Tab) 

(Ctrl)j 

Function 

Editing: backspaces, erasing characters 
In Forms: backspaces, erasing characters 
In Lists: moves you to the parent directory 
Editing: backspaces, erasing characters 
In Forms: backspaces, erasing characters 
In Lists: moves you to the parent directory 
Editing: moves left one space 
In Forms: moves left one space 
In Lists: moves left one item 
Editing: moves left one space 
In Forms: moves left one space 
In Lists: moves you to the parent directory 
Editing: moves to left-most column 
In Lists: unused 
Editing: moves to previous word 
In Lists: unused 
Editing: moves right one character 
In Forms: moves right one character 
In Lists: moves right one item 
Editing: moves right one character 
In Forms: moves right one character 
In Lists: moves right one item 
Editing: moves to end of line 
In Lists: unused 
Editing: moves to next word 
In Lists: unused 
Editing: inserts spaces to next tab stop 
In Forms: moves to next field 
In Lists: unused 
Editing: inserts spaces to next tab stop 
In Forms: moves to next field 
In Lists: unused 
Editing: moves down one line 
In Forms: moves to next field 
In Lists: moves down one item 
Editing: moves down one line 
In Forms: moves to next field 
In Lists: moves down one item 

(Continued on next page) 
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Cursor movement commands 
(Continued) 

Keystroke 

(Ctrl)d 

(PgDn) 

(Ctrl)g J, 

(Ctrl)e 

(End) 

(Ctrl)k 

i 

(Ctrl)gi 

(PgUp) 

(Ctrl)u 

(Ctrl)t 

(Home) 

Function 

Editing: moves down one page 
In Forms: unused 
In Lists: moves down one screenful 
Editing: moves down one page 
In Forms: unused 
In Lists: moves down one screenful 
Editing: moves to bottom of document 
In Forms: unused 
In Lists: unused 
Editing: moves to last character on line 
In Forms: moves to last field on form 
In Lists: moves to end of list 
Editing: moves to last character on line 
In Forms: moves to last field on form 
In Lists: moves to end of list 
Editing: moves up one line 
In Forms: moves to previous field 
In Lists: moves up one item 
Editing: moves up one line 
In Forms: moves to previous field 
In Lists: moves up one item 
Editing: moves to top of document 
In Forms: unused 
In Lists: unused 
Editing: moves up one page 
In Forms: unused 
In Lists: moves up one screenful 
Editing: moves up one page 
In Forms: unused 
In Lists: moves up one screenful 
Editing: moves to left-most column 
In Forms: moves to first field on form 
In Lists: moves to top of list 
Editing: moves to left-most column 
In Forms: moves to first field on form 
In Lists: moves to top of list 
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Keystroke commands 

Insertion and Deletion comands 
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Keystroke 

(Ctrl)o 
(Ctrl)v 
(Ctrl)w 
(Ctrl)y 
(Del) 

Other commands 

Keystroke 

(Ctrl)c 
(Ctrl)f 

(Ctrl)m 
(Ctrl)r 
(Ctrl)x 
(Return) 

(Esc) 

(Space) 

(Fl) 

(F2) 

(F3) 

(F4) 

(FS) 

(F6) 

(!) 

Function 

opens new line 
toggles between Insert and Overwrite modes 
deletes a word 
deletes a line 
deletes a character 

Function 

cancels the current operation 
use in conjunction with a number in place of a function key. 
For example, type (Ctrl)f2 instead of pressing (F2). 

same as (Return) 
refreshes screen 
executes form 
In Menus: selects highlighted menu option 
In Forms: moves to next field in the form 
In Lists: selects highlighted item(s) 
Elsewhere: moves down one line 
In Menus: moves back to parent menu 
In Forms: exits form without executing 
In Lists: exits without selecting 
Editing: exits and saves 
In Lists: marks item(s) for selection 
Elsewhere: moves highlight 
calls up help 
exits 
displays a point-and-pick list 
checks spelling 
searches for a list entry 
calls up the three-month calendar 
starts a system command 
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Appendix B 

Menu options 

This appendix lists all the options available in the sea Shell menus. The main 
or top-level menu options appear in boldface type at the left margin of the 
table. The options listed below each top-level menu option are in lower levels 
of the menu hierarchy. Those with one arrow are in the first-level menus, 
those with two arrows are in the second-level menus, and so on. For instance, 
File is a first-level menu option in the Manager menu, and Copy is an option 
in the File menu. 

Once you are familiar with the menu options, you can enter shorthand menu 
paths to reach lower level options without having to see all of the upper level 
menus. Use the first letter of each menu option to select the option at the end 
of the menu path. In Table B.I, the "Path" column lists the shorthand menu 
path for each menu option. 

If there are no menu options listed below the one you choose, either a form or 
a display appears. For example, when you choose the Application option, a 
scrollable display appears, listing the applications available on your system. 

97 



Menu options 

Table B·1 seo Shell menu map 

seQ Shell Option Path Function 

Application a selects an application 

Manager m manages files and directories 
¢View mv displays a file 
¢Edit me edits a file 
¢File mf manages files 
¢¢Copy mfc copies a file 
¢¢Rename mfr renames a file 
¢¢Erase mfe erases a file 
¢¢Find mff finds a file 
¢¢Unfind mfu returns to the current directory's file list 
¢¢Permissions mfp sets file permissions and ownership 
¢¢Wastebasket mfw manages files in the wastebasket 
¢¢¢Select mfws recovers files from the wastebasket 
¢¢¢Delete mfwd deletes files from the wastebasket 
¢¢¢Clear mfwc deletes all files from the wastebasket 
¢Directory md manages directories 
¢¢Change mdc changes current directory 
¢¢Make mdm creates a new directory 
¢¢Remove mdr removes a directory 
¢¢ Permissions mdp sets directory permissions and ownership 
¢Archive rna saves and retrieves files from removable media 
¢¢Extract mae retrieves files from floppy disk or tape 
¢¢List mal displays a list of files on floppy disk or tape 
¢¢Format maf prepares floppy for Create 
¢¢Create mac loads files onto disk or tape 
¢¢Type mat specifies the format type (tar, cpio, or DOS) 

¢¢Device mad switches to a different device (floppy or tape) 
¢Transfer mt transfers files to or from the Clipboard 
¢¢Copy mtc copies files to the Clipboard 
¢¢Paste mtp pastes files from the Clipboard 
¢¢Remove mtr removes items from the Clipboard 
¢¢Quit mtq returns to File menu 
¢ Preferences mp sets editor preferences 
¢Quit mq returns to main menu 

(Continued on next page) 
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Table B·1 seo Shell menu map 
(Continued) 

seQ Shell Option Path 

Print p 
¢Go pg 
¢Select ps 
¢PrintStatus pp 
¢Cancel pc 
¢Quit pq 

Utility u 

Options 0 

¢Display od 
¢¢FileWindow odf 
¢¢AppWindow oda 
¢¢CalendarWindow odc 
¢Applist oa 
¢¢Add oaa 
¢¢Edit oae 
¢¢Delete oad 
¢¢Undelete oau 
¢¢Switch oas 
¢Utillist ou 
¢¢Add oua 
¢¢Edit oue 
¢¢Delete oud 
¢¢Undelete ouu 
¢¢Switch ous 
¢Save os 
¢Quit oq 

Quit q 
¢Yes qy 
¢No qn 

Function 

controls printers 
sends files to the current printer 
selects the current printer 
displays the status of a printer 
cancels a print job 
returns to main menu 

runs a system utility 

specifies configuration options 
configures desktop display 
configures File window display 
configures Application window display 
configures Calendar window display 
edits Application list 
adds a command or folder to the list 
edits a command or folder 
deletes a command or folder from the list 
restores a command or folder 
switches to another folder 
edits Utility list 
adds a command or folder to the list 
edits a command or folder 
deletes a command or folder from the list 
restores a command or folder 
switches to another folder 
saves window display configuration 
returns to main menu 

leaves seQ Shell 
leaves seQ Shell 
returns to main menu 
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Appendix C 

Setting up your printers 
You can configure your system's printers for use with sea Shell by running 
the Printer Configuration utility, which is executed when you select Printers 
from the Administrative Utilities menu. With this utility, you can create 
printer definition files for all of the different printers available on your system. 
These files include device names and descriptions; print drivers; spooler 
names; and commands associated with each of the above. This utility must be 
run if you want to access any printers other than the default one from sea 
Shell. 

The Printer Configuration utility lets you define which drivers are used by 
your system's printers. Once you define a printer with the utility, the device is 
made available to all sea Shell users from within the program. An individual 
user may then select any of these devices from inside sea Shell. 

Several other sea applications also use the Printer Configuration utility to 
configure their printers. The forms for sea Lyrix and sea Professional include 
application-specific information not found on sea Shell's Printer Con­
figuration form. You must run the utility as described by these applications' 
configuration guides to access your printers capabilities when using these 
programs. 

Each printer you configure may be defined by more than one definition file, 
each file allowing the printer to be controlled by a separate print driver. Infor­
mation on how to create these separate definition files is found later in this 
chapter. 
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Setting up your printers 

Using the Printer Configuration utility 
You must be logged on as root to run the utility. From the operating system 
command line, enter 

scosh 

Select Utility· from the seQ Shell desktop. seQ Shell displays a customized 
utilities list. From this list, select Printers, the Printer Configuration utility. 
seQ Shell presents you with the Printer Configuration menu. From here, you 
can Add, Edit, or Remove printer definition files, or you can specify a Default 
printer other than the line printer defined during installation. 

Creating and editing printer definition files 
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Printer definition files are created and edited by entering information on a 
special form. You can reach this form in several ways, depending on whether 
you are creating a completely new entry, creating an entry similar to another 
already created, or editing an existing entry: 

• If you choose Add from the Printer Configuration menu and then select 
New, you proceed directly to a blank setup form. You can now enter data 
as shown later in this chapter. 

• If you choose Add from the Printer Configuration menu and then select 
Copy, you must highlight a file to copy. Move the cursor up and down 
with the cursor movement, (Home), or (End) keys, or by typing the first 
letter of the definition file you want to copy. Press (Return) when your 
selection is highlighted. You now proceed to the setup form, which con­
tains information copied from the selected file. You can now enter or edit 
data as shown later in this chapter. 

• If you choose Edit from the Printer Configuration menu, you reach the 
setup form after selecting the appropriate file to edit, highlighting its name 
as described above and pressing (Return). 
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Using the Printer Configuration utility 

The setup form 
The setup form is shown here: 

Form Addition 

Enter name printer definition file 
Printer ConfIguration UtilIty 

Name: 
Type: [default 
Description: [ 

Destination : 
Spooler: 
Options: 

Setup string: 
Reset string: 

Page length : 
Page width : 

[Spooled] Direct 
interface: [ 
device: [ 
baud: [ 
stty: [ 

Local 
tty: [ 

'On this form, you enter or edit all of the necessary configuration data for your 
printer. Each choice on the form is described in detail in the following pages. 
To move around the screen, use the cursor movement, (Home), and (End) keys. 
To enter data, simply type it and press (Return). In some cases, which are 
explained in the appropriate sections, data entry is mandatory before 
proceeding to the next portion of the form. 

The program starts in Insert mode. To enter Overstrike mode to overwrite 
existing data, press (Ctrl)v. An indicator at the top of the screen displays Ovr. 
Any data entered now overwrites ,the original data. Pressing (Ctrl)v again tog­
gles back to Insert mode. 

The highlighted area in the upper-right corner indicates what the Printer Con­
figuration utility is currently doing, in this case adding a new definition file. 
This context indicator displays various messages, depending on the program's 
current status. 
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Setting up your printers 

The following entries can be made on the setup form: 

Name: Enter a printer name of up to 14 characters; do not use spaces or 
metacharacters such as * { ( or I. This name is displayed as a 
printer choice to users running sea Shell. If you are adding a 
new definition file, this entry is mandatory. If you enter the 
name of an existing file, a message box appears, asking if you 
want to overwrite the existing file. If you choose No, you return 
to the name field to enter a new name. 

Type: Press (F3) for a list of supported printer types. Select the correct 
type by moving the highlight bar and -pressing (Return). If no 
type is available for your particular device, choose default. 
This entry is mandatory. 

Description: Enter a short description of the printer, one which is recogniz­
able to the users of sea Shell. This description, shown with the 
printer name when selecting a printer during sea Shell ses­
sions, should give your users even more information about 
their choice. This entry is mandatory. 

Destination: Select one of the three choices: Spooled, Direct, or Local. Each 
of these options, along with its sub-options, is described below. 
Enter your selection by moving to the correct choice and press­
ing (Return). This entry is mandatory. 

If you choose Spooled as the print destination, sea Shell output 
is sent to the designated spooler. Consult your system adminis­
trator or operating system documentation for more information 
on spooler names and options. 

Spooler: Enter the name of the appropriate spooler. 

Options: Enter any appropriate spooler options in the form -option. For 
example, the option -d destination sends spooled output to a 
particular device. 

If you choose Direct as the print destination, sea Shell output is 
sent directly to the designated parallel or serial device. Consult 
your system administrator to determine the correct device 
name, and see your terminal and printer documentation for 
more information on baud rate and stty settings. 

Interface: Type s for Serial or p for Parallel, and then press (Return). 

Device: Enter the device name in the form fdev/name. 

Baud: Enter the baud rate at which output is sent to the direct device. 
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Using the Printer Configuration utility 

stty: Enter any appropriate stty settings. For example, the setting 
xon xoffindicates the handshake mode of the printer. 

If you choose Local as the print destination, sca Shell output is 
sent directly to the designated tty. Consult your system 
administrator to determine the appropriate tty name. 

tty: Enter the appropriate tty name. 

If you want to include special font, point size, overstriking, or 
other initialization and de-initialization strings, enter this infor­
mation in the Setup String and Reset String areas of the form. 
Consult your printer documentation for more information on 
the use of setup strings. 

Setup String: Enter a setup string in the form \setup string. For example, the 
setup string \015 could put a printer into overstrike mode. 

Reset String: Enter a reset string in the form \reset string. For example, the 
reset string \016 could return a printer from overstrike mode. 

Page Length: Enter a number of lines per page. The default value is 66. 

Page Width: Enter a number of characters that can be printed on one line. 
The default value is 80. 

Quitting Add or Modify 
If you want to quit without accepting any of the changes you have made to 
the form, press (Esc). Once you have made all changes, press (Ctrl)x to record 
them, or move to the bottom of the screen and press (Return). In all cases, you 
return to the Printer Configuration menu. 

Removing entries 

To remove a definition file from the list of those available for use within sea 
Shell, select Remove from the Printer Configuration menu. Highlight the 
appropriate file to remove. Press (Return). Type y to confirm or n to cancel the 
removal. You now return to the Printer Configuration menu. 

You cannot remove the printer selected as the system's default. To remove this 
printer, you must first select another default printer by using the process 
shown next; then remove the previously designated default printer. 
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Setting up your printers 

Choosing a default printer 

To choose a default printer for your users' sea Shell sessions, select Default 
from the Printer Configuration menu. Highlight the printer you want to serve 
as your sea Shell default device. Press (Return). The default device is 
highlighted at the top of your screen, 'and you are returned to the Printer Con­
figuration menu. 

Quitting the Printer Configuration utility 
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When you finish configuring your printers, select Quit from the Printer Con­
figuration menu. The program asks you to confirm this command. Select Yes 
to quit the utility, No to remain in the program. 
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Glossary 

absolute pathname 
A pathname for a file or directory that begins at the root directory. Every 
absolute pathname begins with a slash character (/), which stands for the root 
directory. See also PATHNAME and RELATIVE PATHNAME. 

application 
A computer program that performs a particular task. Word processing, 
spreadsheet, and database programs are all applications. 

application folder 
A sublist on the main Applications list, which usually includes a list of related 
application programs. An application folder can contain applications and 
other application folders. See also APPLICATIONS LIST. 

applications list 
The list of available applications and application folders that is displayed on 
the main sea Shell screen. See also APPLICATION FOLDER. 

archive 
To place a file or group of files in a form convenient for storage on backup 
media such as floppy disks or tape. Normally, you can archive backup files or 
files that are important but not often used. Such files can be copied to and 
from backup media using the Archive option on the File menu. See also 
BACKUP. 

arrow keys 
The four arrow keys control cursor movement. When you are using sea 
Shell, the arrow keys move the cursor up, down, left, and right. 

ascending order 
The default order in which files and directories are displayed in the File win­
dow on the main sea Shell screen. Ascending order displays files alphabeti­
cally (A before B before C, and so on), and directories precede files. Numbers 
precede letters (smaller numbers before larger numbers) and capital letters 
precede lowercase letters. See also DESCENDING ORDER. 

backup 
A copy of a file that is made in case the original is lost or damaged. The 
Archive option on the File menu allows you to copy files to backup media for 
safekeeping. See also ARCHIVE. 

calendar window 
One of three possible display windows on the sea Shell screen. The Calendar 
window shows the current month with today's date highlighted. You can also 
view past or future months from the Calendar window. 
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clipboard 
An sea Shell utility that allows you to transfer information between applica­
tions or within an application. The Clipboard provides a temporary storage 
place for information and translates it from its original file format to the 
correct type, if necessary. See also DATA INTEGRATION and FILETYPE. 

current directory 
The directory you are working in at the moment. The files in the current 
directory are displayed in your File window on the screen. 

database 
A collection of information, or data, organized in a specific order and format 
so that the information can be retrieved, stored, and manipulated by an appli­
cation. 

data integration 
The ability to transfer information between different programs and applica­
tions. For example, the ability to copy data from a spreadsheet into a report 
being created with a word processing program. See also CLIPBOARD and FILE­
TYPE. 

descending order 
The order in which files and directories are displayed in the File window on 
the sea Shell screen. Descending order displays file and directory names in 
reverse, alphabetically (Z before Y before X, and so on). Directories precede 
files in reverse alphabetical order. Letters precede numbers (larger numbers 
before smaller numbers), and lowercase letters precede capital letters. See 
also ASCENDING ORDER. 

directory 
A logical subdivision of the filesystem. Directories contain files and other 
directories. 

display windows 
Defined areas of the screen that display specific information, such as file list­
ings or a menu of available applications. You can customize window size, 
location, and content. 

document 
A collection of text,. edited and formatted with word processing commands, 
located in a file. 

edit mode 
In forms, the ability to use editing commands to modify text and data. Edit 
mode is invoked automatically when you select the Edit option from the Man­
ager menu. See also FORM. 

error message 
A message informing you that the computer cannot perform the task you 
requested. The error message briefly describes the nature of the problem. 
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escape key 
Marked Esc on your terminal keyboard, use this key to abandon the current 
command or return to the previous menu. 

field 
An area in a form in which you record specific information, such as a name or 
date. See also FORM. 

file 
A unit of information storage. When you use an application, it generally cre­
ates a file that stores your work. 

filetype 
The format in which information is stored. Some applications accept informa­
tion only of a particular type. The clipboard can convert information from 
one type to another. See also CLIPBOARD and DATA INTEGRATION. 

form 
An area on the screen where data is entered and displayed. Forms are used 
for entering, searching, modifying, and deleting data. While in a form, you 
are in Edit mode. See also EDIT MODE and FIELD. 

full pathname 
See ABSOLUTE PATHNAME. 

function keys 
On most terminals, a set of keys that can be programmed to perform com­
mands. See also QUICK REFERENCE KEYS. 

help screens 
Provide information about the part of sea Shell that you are currently using. 

home directory 
Your personal directory. When you first log into your computer, your home 
directory is the current directory. 

login name 
The name through which you gain access to the operating system. When you 
are logging onto the computer, you must enter this login name, followed by a 
password. 

menu 
A screen display that lists options that users can select. Each option causes an 
action to be taken or another menu to be displayed. See also OPTION. 

option 
The choices offered on a menu. Options invoke a screen or another menu and 
are selected by typing the first letter of the option name, or by moving the 
highlight to the option name and pressing (Return). See also MENU. 
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paste 
Place information or text from the Clipboard into a file, such as a word pro­
cessing document or spreadsheet. This operation is performed from the 
Transfer menu of the application that you are using. 

pathname 
A list of the directories leading to a particular file or directory. Each directory 
in the pathname is a subdirectory of the preceding directory. See also ABSO­
LUTE PATHNAME and RELATIVE PATHNAME. 

permissions 
Controls who can read, change, and execute particular files or directories. 

point-and-pick 
A method of selecting a command or file to edit by using the arrow keys to 
highlight one or more selections on a list. See also SCROLL BAR. 

prompt 
A line on the screen asking the user to enter information required by the pro­
gram. 

quick reference keys 
Keystrokes that provide a quick way to perform a number of useful functions: 
getting help, exiting applications, displaying point-and-pick lists, searching 
for an entry in a point-and-pick list, and displaying a calendar month. See 
also FUNCTION KEYS. 

relative pathname 
A pathname that begins at the current directory. See also ABSOLUTE PATHNAME 
and PATHNAME. 

screen 
A display where the user views or enters specific information. 

scroll bar 
A small cursor-like marker on the right-hand side of the point-and-pick list 
box that shows your relative position on the list. See also POINT-AND-PICK. 

shell escape 
A method of invoking operating system commands from within sea Shell or 
an application. In sea Shell menus, type ! and then enter the system com­
mand. 

spreadsheet 
A collection of information arranged in rows and columns. Typical uses for 
spreadsheets include balancing income versus debits, preparing taxes, and 
performing data analysis. 

status line 
A line near the top of the screen that provides information about whatever 
sea Shell screen or form you are viewing. 
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subdirectory 
A directory that resides within another directory. Every directory except the 
root directory is a subdirectory. 

utility 
A program that is part of the operating system. Users can access operating 
system utilities from sea Shell. 

wastebasket 
A directory where deleted files are temporarily stored. Once you delete a file, 
it remains in the wastebasket directory until you exit sea Shell, at which point 
all files in the wastebasket are permanently deleted. You can recover files 
from the wastebasket (provided you have not exited sea Shell) using the 
Wastebasket option on the File menu. 

wildcard characters 
Characters used to represent one or more other characters. The wildcard 
characters are" *" and "?". 

wordprocessUng 
Creating, changing, and formatting text, using a program or group of pro­
grams designed especially for those tasks. 
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Index 

A 
Absolute pathname, 32 
Application folders, using, 24-26 
Application option, sca Shell menu, 10,23 
Application window 

configuring, 72 
example of, 23 

Applications 
Applications list 
See also Configuring sca Shell 

adding a program, 75, 78 
default display, 23 
editing the list, 74, 79 
removing a listing, 81 
restoring a listing, 81 
the * character, 76 

Applist menu, 74-75 
definition of, 7 
list of available applications, 76 
selecting from the Applications list, 23 

Applications list. See Applications, 
Applications list 

Archiving, 50, 52 
Arrow keys, 3 
Ascending order, 72 
Auto Editor, 56 

B 
Back-up files, 50 

c 
Calendar key, 18 
Calendar window 

configuring, 73 
example of, 18 

Canceling an operation, 11 
Clipboard 

See also Data integration 
clipboard filetypes, 60 
c~~Ying data from unsupportive programs, 

Clipboard (continued) 
copying to the Clipboard, 60 
definition of, 57 
features of the program, 57 
filetypes, 60-61 
methods for using, 59 
moving information among applications 
57-58 ' 

naming clipboard items, 60-61 
pasting clipboard items, 61 
storing often-used data, 58 
Transfer menu, sca Shell, 59 
translating file formats, 58 
using from sea Shell, 59 

Configuring sca Shell 
See also sca Shell 
Application window, 72 
Calendar window, 73 
changing the screen display, 69 
File window, 71 
aptions menu, using, 68-69 
saving changes, 73 

Context indicator, 9 
Conventions used in this guide, 4 
Current directory, 32 

D 
Data integration, 57. See also Clipboard 
Descending order, 72 
Description line, 9 
Directories, definition of, 29 
Diskette, floppy, as archive media, 54 
Display windows, sca Shell, 9, 70 
Divider line, 9 

E 
Editing text files, 39 
Error messages, 37 
Escape key, 10 
Exiting 

Exit key, 16 
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Exiting (continued) 
from SCQ Shell, 16, 21 
menu selections, 16,56,65,73 

F 
Fields, definition of, 11 
File menu 

copying files, 43-44 
description of, 42 
file permissions 

changing, 46 
definition of, 46 
File Permissions form, 47 
viewing permissions, 47 

finding files, 45 
recovering erased files, 48 
removing files, 45 
renaming and moving files, 44-45 
using, 43 

File Permissions form, 47 
File Suffix field, Auto Editor, 56 
File window 

configuring, 38, 48, 71 
example, 38 

Files, definition of, 29 
Filetypes, 60 
Floppy diskette, as archive media, 54 
Forms 

definition of, 3 
using, 11 

Full pathname, 32 
Function keys, unshifted, 14 

H 
Help screens 

Help key, 15 
Help menu, 15-16 

Hierarchy, SCQ Shell menus, 97 
Home directory, 30 

K 
Keystroke commands, 93-96 

arrow keys, 3 
cursor movement, 94-95 
deletion commands, 96 
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Keystroke commands, 93-96 (continued) 
insertion commands, 96 
other commands, 96 

L 
List key, 17 

M 
Manager menu 

See also Managing files 
archiving files, 50-54 

Archive menu, 50 
copying files, 52 
definition of, 33 
device address, 53 
extracting files, 51 
formatting archive media, 52 
listing files on backup media, 52 
preparations, 50 

copying files, 33 
editing files, 33 
exiting, 56 
finding files, 33 
selecting, 33 
setting editor preferences, 33, 55 
transferring files using Clipboard, 33, 55 
using, 29, 33, 37 
using directories 

changing current directory, 33, 35, 49 
creating new directories, 49 
definition of, 29 
removing directories, 49 

viewing files, 33, 37 
Manager option, SCQ Shell menu, 10 
Managing files 

See also File menu 
archiving files, 50, 52 
canceling operations, 37 
changing directories, 35, 49 
copying files, 43-44 
definition of file and directory, 29-30, 32 
Manager menu 
selecting files, 34 
selecting menu options, 34 
naming files and directories, 32 
organizing files and directories, 32 
pathnames, 31-32 



Managing files (continued) 
removing files, 45 
renaming and moving files, 44 
transferring files using Clipboard, 55 
using wildcard characters, 35 
viewing files, 37 

Menu line, 9 
Menus, SCO Shell options, 97 
Menus, selecting options, 10 

N 
Naming files, 32 

o 
Operating system 

shell commands, 27 
shell escapes, 19,27 

Options, list of, 97 
Options menu, SCO Shell, 68 

p 
Pathname, definition of, 31 
Permissions, definition of, 46 
Point-and-pick lists 

definition of, 12 
List key, 17 
picking items, 12-13 
scrolling, 13-14 

Print drivers 
adding a definition file, 102 
defined by Printer Configuration 
utility, 101 

modifying a definition file, 102 
removing a definition file, 105 

Print option, SCO Shell menu, 10, 63 
Printer Configuration utility 

adding a printer definition file, 102 
choosing a system default printer, 106 
defining a printer for multiple modes, 101 
defining drivers with, 101 
executing, 102, 104-105 
introduction to, 101 
leaving, 106 
modifying a printer definition file, 102 
removing a printer definition file, 105 

Printer Configuration utility (continued) 
setting driver options, 102 

Printing from SCO Shell 
canceling print jobs, 65 
exiting the Print menu, 65 
Print menu, using, 63 
selecting printers, 64 
sending files to the printer, 64 
status of print jobs, 65 

Q 
Quick reference keys 

Calendar key, 18 
description of, 14 
Exit key, 16 
Help key, 15 
List key, 17 
Search key, 17 

Quick reference line, 9 
Quit option, SCO Shell menu, 10, 21 

R 
Relative pathname, 32 
Right margin, setting for text editor, 56 

s 
SCO Shell 

See also Configuring SCO Shell 
Application option, 23 
Application window, configuring, 72 
archiving files, 50, 52 
Calendar window 

Calendar key, 18 
example of, 18 
configuring, 67, 73 

display windows 
Application window 

configuring, 72 
example, 24 

File window 
configuring, 38, 48, 71 
example, 38 

exiting from, 16,21 
features, 7 
File window, configuring, 38, 48, 71 

Index 
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sca Shell (continued) 
forms and fields, 11 
help screens, 15 
lower-level menus, 11 
aptions menu, 68 
point-and-pick lists 

definition of, 12 
List key, 17 
picking items, 12-13 
scrolling, 13-14 

running applications, 23 
sca Shell menu, 8-11 
searching for items, 17 
selecting menu items, 10 
Utility option, 26 

sca Shell menu, 10 
sea Shell screen 

configuring, 69 
context indicator, 9 
default display, 8 
description line, 9 
display windows, 9,71-73 
divider line, 9 
menu line, 9 
quick reference line, 9 
status line, 9 

sea Shell, shortcuts, 97-99 
Scroll bar, definition of, 14 
Search key, 17 
Selecting 

applications, 23 
files, 34 
menu items, 10, 34 
printers, 64 
utilities, 26 

Shell commands, 19, 27 
Starting sea Shell, 8 
Status line, 9 
Subdirectory, 30 

T 
Text editing, preferences, 55 
Text files, editing, 39 
Transfer menu, 55,57, 59 
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u 
Utilities 

definition of, 7 
selecting from the Utility menu, 26 
using Utility folders, 27 
Utilities list 

See also Configuring sca Shell 
default display, 26 
menu, 26 

Utility folders, using, 27 
Utility option, sca Shell menu, 10,26 

w 
Wastebasket, 48 
Wildcard characters, 35 
Windows 

Applications list, 23, 72 
Calendar window, 18, 73 
configuring, 70 
File window, 38, 48, 71 
sca Shell, 9 
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